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Foreword 
 
This manual was created by Hologic, Inc. It is intended to guide the advanced user on how to setup, install and use the Faxitron 
Core hardware and the Vision Software System, both developed by Hologic, Inc. 
 
The user must first setup the hardware, then initiate the Vision Software. Please review the required setup procedures in Section 
4 of this manual before continuing. 
 
 
 
 
 
Indications for Use 
 
The Faxitron Core Digital Specimen Radiography (DSR) System is a cabinet digital X-ray imaging system intended to 
generate and control X-rays for examination of various anatomical regions, and to provide rapid verification that the correct 
tissue has been excised during percutaneous biopsy. Performing the verification directly in the same biopsy procedure room 
enables cases to be completed faster, thus limiting the time the patient needs to be under examination. Specimen radiography 
can potentially limit the number of patient recalls. This device is intended to be operated wherever the medical professionals 
deem appropriate, including a surgical suite or a room adjacent to a surgical suite.  
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This manual was created by Hologic, Inc.  It is intended to guide the user on how to setup, install 
and use the Faxitron Core hardware and Vision Software, both developed by Hologic, Inc. 
 
The user must first setup the hardware, then initiate the Vision Software. At a minimum, please 
review the required setup and safety procedures in this manual before attempting to operate 
the system. 
 
Thank you from all of us at Hologic, Inc. 
 
Additional Information 
 
For further technical assistance contact: 
 

Hologic, Inc. 
36 Apple Ridge Road 
Danbury, CT 06810 USA 
1.800.447.1856 
www.hologic.com 
 

Authorized European Representative  
(for regulatory information) 
Hologic, BV 
Da Vincilaan 5 
1930 Zaventem 
Belgium 
Tel: +32 2 711 46 80 
Fax: +32 2 725 20 87  

 

 

  

 

 1.0.0 
Introduction 
 
 
 
 
 
 
 
 
 
 
 
 

 
The following symbols are used in this manual and online help system: 
 
 
Warns the reader of potential electrocution should the reader ignore the warning 
and deliberately use specialized tools to open a sealed electrical cabinet and 
handle its contents. Note: No tools are provided by Hologic, Inc. 
 
 
Warns the reader of a hazardous condition. This symbol is generally accompanied 
by a more specific symbol and appropriate instructions as to the nature of the 
hazard, the expected outcome of the hazard, and information on avoiding the 
hazard. 
 
 
Cautions the reader to use care in lifting heavy equipment in order to avoid 
personal injury and damage to the equipment. 
 
 
Warns the reader that ionized radiation is emitted into the labelled area when the 
x-ray beam is energized. The Faxitron Core has safety interlocks to prevent the 
labelled area from being accessed while the x-ray beam is energized. 
 
 
Warns the reader to use appropriate protection (such as surgical gloves or an 
approved specimen container) to avoid exposure to potentially infections materials 
such as patient tissue samples. 

  
1.1.0 
Warning and 
Caution Symbols 
in this Manual 

 

http://www.hologic.com/
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Radiation is energy in the form of waves or particles.  High frequency, high energy radiation, 
which has sufficient energy to displace an electron from its orbit around a nucleus, is referred 
to as ionizing radiation.  X-rays, gamma rays, beta particles, alpha particles, and neutrons are 
all forms of Ionizing radiation and can be given off by radioactive material, stars, and high-
voltage equipment. 

We cannot see, feel, taste, smell, or hear ionizing radiation, so monitoring equipment is required 
for us to detect it. 

X-Rays 
X-rays are high frequency, high energy radiation having sufficient energy to displace an electron 
from its orbit around a nucleus and are called “ionizing” radiation.  X-rays are capable of 
traveling long distances through air and most other materials.  The amount of energy carried by 
radiation is directly proportional to the frequency, and inversely proportional to the wavelength.  
X-rays have a relatively short wavelength and high frequency, thus possess a great deal of 
energy. 

X-rays can produce biological changes in tissue that can be beneficial when used in radiation 
therapy.  However, x-rays can also be harmful to biological organisms because of their ability 
to damage chromosomes. 

Sources of X-Ray radiation in medical facilities include: 

X-ray Machines.  X-Ray machines are used for treatment (radiation therapy) and diagnostic 
purposes.  Diagnostic X-Ray machines are used to X-Ray various parts of the body, chest, leg, 
breasts, etc for diagnostic purposes.  Today, in the US alone, diagnostic radiology accounts for 
two‐thirds of our dose from man‐made sources.  X-Ray machines can produce high levels of 
ionizing radiation. 

Cabinet X-ray machines.  Cabinet x-ray machines are enclosed, shielded, and interlocked 
irradiation chambers. The machine can only operate when the chamber door is securely closed. 
The exposure rates at every location on the exterior meets the rate specified for uncontrolled 
areas. 

Sources of Radiation 
We are all exposed to radiation every day.  According to the NCRP, National Council on 
Radiation Protection, the average background dose in the United States is 360 mrem/year (3.6 
mSv/yr).  These exposures are mostly from natural sources of radiation, such as radon, cosmic 
radiation, and natural deposits in the earth.  Even our bodies contain natural radioactivity! 

There are 2 sources of radiation:  Natural and Man-Made. 

Natural Sources of Radiation include Cosmic rays, Terrestrial gamma rays, Radionuclides in 
the body, and Radon and its decay products.  The worldwide average annual effective dose 
from natural sources is estimated to be 2.4 mSv (240mrem).  There are factors that affect the 
effective doses from these natural sources of radiation:  The cosmic ray dose rate depends on 
height above sea level and latitude, the terrestrial gamma-ray dose rate depends on local 
geology, and the dose from radon decay products depends on local geology and housing 
construction and use.  See Table 1 for annual effective doses from these natural sources. 

Table 1 
Annual effective dose to adults from natural sources 

Source of exposure Annual effective dose (mSv) 
Typical Elevated * 

Cosmic Rays 
Terrestrial gamma rays 
Radionuclides in the body (except radon) 
Radon and its decay products 

0.39 
0.46 
0.23 
1.3 

2.0 
4.3 
0.6 
10 

TOTAL (rounded) 2.4 - 
*The elevated values are representative of large regions.  Even higher values occur locally. 
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Medical X-Rays are a major source of man-made radiation.  Medical X-rays utilize ionizing 
radiation for both the diagnosis and treatment of injuries and disease.  UNSCEAR (United 
Nations Scientific Committee on the Effects of Atomic Radiation) estimates that individual 
exposure to medical radiation ranges from 0.4 to 1 mSv annually.  Exposure from medical 
radiation exceed those from all other man-made sources, but amount to less than half the 
exposure to natural background radiation.  

The doses of ionizing radiation used in diagnostic X-rays are usually quite low, ≤50KeV. 

 
The chart below shows the contributions from various sources of radiation. 

 
 
 
 
 
 
Exposure to ionizing radiation can have adverse health effects by causing atoms and molecules 
to change.  When ionizing radiation passes through tissue, large amounts of energy are 
transferred to individual molecules.  This energy transfer causes electrons to be dislodged from 
atoms, initiating a variety of chemical and physical effects.  The most critical of these effects is 
damage to DNA molecules.  The body has mechanisms in place that normally repair this 
damage, but extensive or certain types of damage may not be repaired.  When the body is 
unable to repair the damage the cell may die or be mutated.  Mutated cells have the potential 
to turn into cancers.  The extent of damage is proportional to the energy imparted, or the dose 
of ionizing radiation received.   

Health effects of exposure to x-ray radiation come in two general types, direct or indirect.  X-
rays are thought to create radicals in exposed cells of your body that may break or modify 
chemical bonds within critical biological molecules. 

 2.2.0 Cont. 
 
 
 
 
 
 
 
 
 
 
Figure 2.2.1  
Sources of Radiation Dose in 
the Unites States. 
 
From NCRP 160, Fig. 1.1. 
Percent contribution of various 
sources of exposure to the total 
collective effective dose 
(1,870,000 person-Sv) and the 
total effective dose per individual 
in the U.S. population. 
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As a result  

(1) Cells may be injured or damaged, although many cells repair themselves, resulting in no 
residual damage,  

(2) Cells may die, which millions of body cells do every day, and are replaced in a normal 
biological process,  

(3) Cells may incorrectly repair themselves, resulting in a biophysical change.  Finally, X rays 
may pass through the body with no interaction. 

 
The damage to cells from ionizing radiation can result in: 

• Production of free radicals 
• Breakage of chemical bonds 
• Production of new chemical bonds and cross-linkage between macromolecules 
• Damage to molecules which regulate vital cell processes (e.g. DNA, RNA, proteins) 
 
Dose Rate, Total Dose Received, Energy of the radiation, Area of the body exposed, the 
individual’s sensitivity, and Cell sensitivity, are all factors that determine the biological effects of 
radiation exposure. 

There are two types of effects from exposure to ionizing radiation:  deterministic effects and 
stochastic effects. 

 

 

 

DETERMINISTIC AND STOCHASTIC EFFECTS 

Potential biological effects depend on how much and how fast a radiation dose is received. 
Radiation doses can be grouped into two categories, acute and chronic dose. 

Acute Dose and Deterministic Effects 

Acute radiation exposure is a high radiation dose occurring over a short period of time, normally 
seconds to days.  The effects caused by acute radiation doses are called deterministic; the 
severity of the effect is determined by the amount of dose received. Deterministic effects usually 
have some threshold level - below which, the effect will probably not occur, but above which the 
effect is expected. Above the threshold, the severity of the effect increases as the dose 
increases. 

For example, a whole body dose of about 300 rems (3 Sv), 60 times the annual occupational 
dose limit, if received within a short time period (e.g., a few hours) will cause vomiting and 
diarrhea within a few hours; loss of hair, fever, and weight loss within a few weeks; and about 
a 50 percent chance of death without medical treatment. These effects would not occur if the 
dose 300 rems (3 Sv) were accumulated gradually over many years. 

There is also a difference between whole body and partial body exposures.  Where an acute 
dose of 600rem (6 Sv) to the hand would cause skin reddening; recovery would occur over the 
following months and no long-term damage would be expected.  However, an acute dose of 
that magnitude to the whole body could cause death within a short time without medical 
treatment. 

The utilization of appropriate radiation protection mechanisms and occupational exposure dose 
limits reduce the likelihood of these effects occurring. 

The occupational dose limits are far below the thresholds for deterministic effects. 

 2.3.0 Cont. 
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Chronic Dose and Stochastic Effects 

A chronic dose is a relatively small amount of radiation received over a long period of time (e.g. 
years). The body is better equipped to tolerate a chronic dose than an acute dose, since the 
body has time to repair damage because a smaller percentage of the cells need repair at any 
given time. The body also has time to replace dead or non-functioning cells with new, healthy 
cells. However, this does not mean there is no risk related to chronic radiation exposure. 

The term stochastic means “random”, with the implication that low levels of radiation exposure 
are not certain to produce an effect. These low levels, below the threshold for deterministic 
effects, may or may not result in detrimental effects to the body. 

However keep in mind that:  

1) There is no threshold level of radiation exposure below, which we can say with certainty that 
effects will not occur 

2) Doubling the radiation dose, doubles the probability that effects will occur.   

Chronic exposure may produce only effects that can be observed some time following initial 
exposure.  These may include genetic effects and other effects such as cancer, precancerous 
lesions, benign tumors, cataracts, skin changes, and congenital defects.  Generally, the 
greatest concern is the development of some form of cancer. 

Immediate effects are not seen below doses of 25 rem (0.25 Sieverts).  Latent effects may 
appear years after a dose is received.  It has been found through studies of populations exposed 
to ionizing radiation (> 0.5 Sv) that the probability of a fatal cancer occurring from radiation 
exposure is approximately 5 percent per Sv. 

 

 

RADIOSENSITIVITY 

Radiosensitivity is the probability of a cell, tissue, or organ suffering an effect per unit dose of 
radiation.  Radiosensitivity is highest in cells which divide rapidly (highly mitotic) or are relatively 
non-specialized (undifferentiated).  For this reason the basal epidermis, bone marrow, thymus, 
gonads, and lens cells are highly radiosensitive.  Muscle, bones, and nervous system tissues 
have a relative low radiosensitivity.  Also, radiosensitivity is greatest during the fetal stage and 
becomes progressively smaller through adolescence and adulthood. 

Basic Law of Radiobiology:  Biological effects are directly proportional to the mitotic index and 
the mitotic future of the exposed cell, and inversely proportional to the degree of differentiation.  
Mitosis refers to the natural division of a cell nucleus during cell reproduction;   differentiation 
refers to the cell’s degree of specialization to perform a specific function in an organism. 

 

 

RISKS FROM RADIATION EXPOSURE  

It is estimated that approximately 20% (1 in 5) of all deaths in the United States are due to some 
type of cancer. 

If every member of a population of 1 million were to receive 10 mrem (0.1 mSv) of radiation, it 
is possible that 5 additional deaths would be observed. Remember that out of this population of 
1 million, about 200,000 will die of cancer, making these few additional deaths statistically 
impossible to detect. 

Additionally, the risk of cancer death is 0.08% per rem (10 mSv) for doses received rapidly 
(acute) and might be 2 times (0.04%, or 4 in 10,000) less than that for doses received over a 
long period of time (chronic). 

 2.3.1 Cont. 
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From currently available data, the NRC has adopted the risk value for an occupational dose of 
1 rem (0.01 Sv) as representing a risk of 4 in 10,000 of developing a fatal cancer. 

The International Commission on Radiological Protection (Publication 103, 2007) indicates a 
value of 5.5 % per sievert for cancer and 0.2 % per sievert for heritable effects after exposure 
to radiation at low dose rate 

The risk associated with the diagnostic uses of ionizing radiation are normally limited to late 
stochastic effects, which are estimated to occur at a frequency of perhaps 0.01% for an average 
examination (deterministic skin damage may occur after fluoroscopy in extreme cases).  At the 
individual level, these risks are almost always small compared to the benefit of diagnosis and 
treatment.   

 

 

CONCLUSIONS ON HEALTH RISKS 

We assume that any radiation exposure, no matter how small, carries with it some risk.  
However, we know that on average these risks are comparable to or smaller than risks we 
encounter in other activities or occupations that we consider safe.  Since we have extensive 
control over how much radiation exposure we receive on the job, we control and minimize this 
risk.  The best approach is to keep our dose As Low As Reasonably Achievable, or ALARA – a 
term we will discuss in detail later.  Minimizing the dose minimizes the risk. 

 

 

ICRP DOSE LIMITS 

The international Commission on Radiological Protection (ICRP) has established radiation dose 
limits based on available data.  These dose limits are maximum allowed values for whole body 
exposures.  The dose unit of measure is called the Sievert (Sv) which accounts for various 
factors to determine a quantity called effective dose.  The dose limits were last updated in 2007. 

For members of the public the dose limit is 1mSv/yr (0.001 Sieverts per year) 

For occupational workers (those who work in the nuclear industry the dose limit is 20 mSv/yr 
(0.02 Sieverts per year) 

The dose limits exclude the effects of background radiation. 

 

ICRP Recommended annual dose limits for individual organs or tissues 
Radiation weighted dose in Workers Public 

Lens of the eye  150 mSv 15 mSv 
Skin 1,2  500 mSv 50 mSv 
Hands and feet  500 mSv - 

1. The limitation on effective dose provides sufficient protection for the skin against stochastic 
effects. An additional limit is needed for localised exposures in order to prevent tissue 
reactions. 

2. Averaged over 1 cm2 area of skin regardless of the area exposed. 
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Determining Factors 

The effects of x-ray exposure depend upon the duration of exposure, how fast the dose is 
delivered, Energy – How much energy was in the x-ray, the total dose – the magnitude of the 
dose, and whether the exposure is whole body or localized.  Low energy (<50KeV) X-rays can 
cause damage only to skin or outer part of body while high energy X-rays can penetrate the 
body to the internal organs.  A large acute dose delivered at once would have a greater effect 
than the same dose administered over time as incremental fractions. 
 
In medical environments risk of radiation exposure can be minimized by: 

• Avoiding all unnecessary exposures to radiation 
• Using Doses that are  As Low As Reasonably Achievable (ALARA) 
• Following equipment manufacturers operating instructions 
• Following equipment manufacturers preventive maintenance instructions 
• Utilizing appropriate shielding 

 

 

ALARA 

The ALARA concept is based on the assumption that any radiation dose, no matter how small, 
can have some adverse effect.  Under ALARA, every reasonable means of lowering exposure 
is used. 

There are three general rules to reduce a person's exposure to any type of ionizing radiation 

1. Reduce the time you are exposed to the radiation source.   
• Reducing the exposure time reduces the radiation dose. 

2. Increase the distance between yourself and the radiation source. 
• Increasing the distance from a source of radiation significantly reduces the 

radiation dose. 
• Doubling the distance from a radiation source means one-fourth the dose rate. 
• Tripling the distance gives one-ninth the rate. 

3. Increase shielding between yourself and the radiation source.  
• The use of appropriate shielding greatly reduces dose. 
• The material used and thickness of the shied depends on the source of the 

radiation. 
• Lead is a common shielding material. 

 

Consult your Radiation Safety Officer for the rules and guidelines of specific to your facility. 
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The Faxitron Core Digital Specimen Radiography (DSR) System is a compact desktop 
cabinet digital X-ray imaging system intended to provide rapid verification of core biopsies. 
 
Performing the verification directly in the same biopsy procedure room enables cases to be 
completed faster, thus limiting the time the patient needs to be under examination. Specimen 
radiography can potentially limit the number of patient recalls. The Faxitron Core's small 
footprint allows it to be setup in surgical suites or offices with limited space. 
 
The Faxitron Core Digital Specimen Radiography System employs the use of Vision, a full 
featured and powerful image acquisition and data manipulation software. Vision software 
handles the digital X-ray image acquisition, calibration, image display, image analysis and 
manipulation, patient database, image archiving, and transmittal. Vision software is the central 
part of this system. Vision software is Digital Imaging and Communications in Medicine 
(DICOM) 3.0 compliant and comes with DICOM Print, Store and Modality Work List (MWL). 
 
 
 
 
DICOM Version 
 
Hologic uses the latest DICOM standard: 
ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, Final Draft, Aug. 
1993 
 
And complies with: 
NEMA PS 3.1 - 3.20 (2016), Digital Imaging and Communications In Medicine Set 
 
 
Storage Classes 
 
Faxitron DR provides Standard Conformance to the following DICOM V3.0 SOP Class as a 
SCU. 
 
SCU SOP Class 
 

SOP Class SOP Class UID 

Computed Radiography Image Storage SOP 1.2.840.10008.5.1.4.1.1.1 
Digital X-ray Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.1 
Digital X-ray Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.1.1 
Digital X-ray Mammography Image Storage 
Presentation 

1.2.840.10008.5.1.4.1.1.1.2 

Digital X-ray Mammography Image Storage 
Processing 

1.2.840.10008.5.1.4.1.1.1.2.1 

Study Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.2.1 
Patient Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.1.1 
Modality Worklist information Model-FIND 1.2.840.10008.5.1.4.31 
Greyscale Softcopy Presentation Storage 1.2.840.10008.5.1.4.1.1.11.1 

 
 
For further details refer to the full DICOM Conformance Statement stored on the system. The 
file is in C:\Faxitron and a shortcut is provided on the desktop. 
 
If required, a copy of the DICOM Conformance Statement is available from Faxitron on request 
 

 3.0.0 
Overview 
 
 
 
 
 
 
 
 
 
 
 
3.0.1 
DICOM Version 
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Service 
 
There are no serviceable parts in Hologic equipment. Please contact your authorized Hologic 
representative for servicing. 
 
Hologic, Inc. 
36 Apple Ridge Road 
Danbury, CT 06810 USA 
1.800.447.1856 
www.hologic.com 
 
Troubleshooting 
 
Refer to the Faxitron Core Technical Manual, contact your Hologic representative, or contact 
Hologic Customer Service. 
 
 
SCHEDULE OF MAINTENANCE 
 
Refer to the Faxitron Core Technical Manual, contact your Hologic representative, or contact 
Hologic Customer Service. 
 
 
 
 
 
 

 3.0.2 
Service and 
Troubleshooting 
 
 
 
 
 
 
 
 
 
 
 
 
3.0.3 
Schedule of 
Maintenance 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.hologic.com/
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SOURCE-to-IMAGER (SID) and SOURCE-to-OBJECT (SOD) DISTANCES: 

• Top of Camera to Imager:     0.230” (5.8mm) 
• Tube Target to Imager:     12.90” (327.66mm) 
• Tube Target to Sample Position:     8.94: (227.08mm) 
• Imager to Sample Position:     3.96” (100.58mm) 
• Effective Magnification:     1.44:1 

 
WEIGHT:  40 lbs (18 kg) 
 
POWER REQUIREMENTS:  120VAC 60Hz 150W Max or 230VAC 50Hz 150W Max                   
  
HEAT OUTPUT:  500 BTU/hr Max 
 
X-RAY DUTY CYCLE:  50% 
 
EXPOSURE CONTROL:  Automatic or Manual 
 
 
 

 3.1.0 
Specifications 
 
 
Figure 3.0.1  
Dimensions & Weight 
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Requirements | Faxitron Core Compliance 

It is the responsibility of the facility or institution operating this system to ensure that all local, 
regional, and federal regulations affecting the use of Ionizing Radiation Equipment are followed 

 

Emission Limits 

X-Ray Radiation emitted from the Faxitron Core unit does not exceed an exposure of 0.3 milli-
Roentgens (mR) per hour at any point 5 centimeters (cm) outside the external surface. For 
countries requiring emission values measured at 10 cm from the external surfaces, the radiation 
does not exceed 0.1 mR per hour at 10 cm. 

 

Safety Interlocks 

The Faxitron Core Specimen DR system has two safety interlocks on the specimen drawer, 
the front access panel, and the back cover to prevent the generation of x-rays unless they are 
closed/installed. 

Start Button 

Following interruption of X-ray generation by the safety interlocks, the Start button on the front 
panel will resume X-ray generation when ready. 

Key Actuated Control 

Key Lock switch located on the front panel, which requires a key to be inserted and turned 
clockwise to the 3 o’clock position in order to provide power to the cabinet system. The key is 
captive in the “ON” position. 

Emergency Stop Button 

The Emergency Stop button on the Faxitron Core front panel is available to terminate the 
generation of X-rays. This is in addition to the safety interlocks on the system drawer. 

X-ray Generation Indicators 

The Faxitron Core has an X-ray On indicator light on the front panel and graphical user 
interface, and also produces an audible tone when generating x-rays. 

Software Access – Optional Password 

The user has the option to implement a “Password” requirement to open Vision software. When 
this option is on the correct “user defined password” must be entered to open Vision software. 
If the correct password is not entered the software closes. 

 

 

X-Ray Control System 

The X-Ray control system consists of the system electronics, Interlock Switches, X-ray On 
Button, Emergency Stop Button, and the system Imaging Software (Vision). 

The Faxitron Core system is fully dependent on the software for image acquisition/X-ray 
generation.   

 3.2.0 
Compliance 
Requirements and 
Safety Measures 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.0 
X-Ray Control 
System 
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The software and controller board firmware monitor system conditions to determine:  

1) If Image Acquisition is allowed  
2) the acquisition parameters (energy level and duration)  
3) If Image Acquisition should be aborted  
4) what, if any messages are to be displayed 
5) The appropriate indicators to activate. 

The following condition must be present for Image Acquisition/X-ray generation to occur: 

1) Vision software must be open 
2) System must be armed – patient data entered 
3) Interlock Switches must be closed 
4) Controller board communicating with System Software (Vision) 
5) Digital Imager communicating with System Software 
6) X-ray On button pressed 

If the above conditions are met: The software determines the image acquisition parameters, 
(energy level and duration), and the software sends these parameters to the controller board.  
The controller processes the signal and routes it to the HVPS (High Voltage Power Supply).  If 
the High Voltage circuit is active, the HVPS generates High Voltage which is sent to the X-Ray 
Tube – X-rays are generated.  Indicators and messages are activated to inform the user that 
Image Acquisition/X-ray generation is in progress. 

If at any time during Image Acquisition an interlock is open the acquisition will be terminated 
and the appropriate indications and messages will be displayed. 

 

Shielding 
The Faxitron Core system is designed to generate ionizing radiation energies at or below 30keV. 

The stainless steel used in the manufacturer of the Faxitron Core X-Ray chamber is a high-Z 
material that effectively absorbs almost 100% of the ionizing radiation at this energy level.  

No additional shielding is required. 

Attenuation 
The primary beam from the Faxitron Core X-ray tube is directed towards the floor of the system.  
Any reflected or scattered beams will be absorbed by the X-ray chamber top, walls, and drawer 
front. 

Typical background radiation measurements at the Hologic manufacturing facility are 0.1 µSv/hr 
(0.01mR/hr). 

Dose measurements are taken at 30keV energy levels with a 6mm acrylic block in the primary 
beam path to represent maximum system energy levels and maximum beam scatter. 
Measurements at accessible surfaces are typically between 0.1 and 0.5 µSv/hour (0.01 and 
0.05 mR/hr). 

 

Hologic advocates following ALARA, As Low As Reasonably Achievable.  Use energy levels no 
greater than necessary to perform the task.  The use of AEC, Automatic Exposure Control, 
ensures that the lowest ionizing radiation energy levels possible will be generated to obtain 
optimum image quality.  With AEC activated the system will take a short sample exposure at a 
predetermined energy level and duration.  The software will evaluate the sample image and 
calculate best energy and time settings. 

 3.3.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.4.0 
Shielding and 
Attenuation  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.5.0 
ALARA 
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REGULATORY REQUIREMENTS 

It is the responsibility of the facility or institution operating this system to ensure that all local, 
regional, and federal regulations affecting the use of Ionizing Radiation Equipment are followed. 

 

Warnings 

• Please read the instructions carefully before using the system. 

• Do not use the system in any other way than its intended use as described in this manual, if 
in doubt contact Hologic or your authorized distributor. 

• Not all power cords have the same rating. Do not use any other power cord with this system 
other than the one provided. Do not use the power cord from this system on any other 
equipment. 

• This system is tested to the highest international standards, however it is recommended that 
you contact your national authorities regarding any local operational requirements. 

• This system is not intended for public use. It must be located in an area where the general 
public cannot access the system without an operator being present. 

• Use of controls or adjustments to perform procedures other than those specified herein may 
result in hazardous radiation exposure. 

 

General Precautions 

The following precautions must be taken to prevent damage to your Faxitron Core System: 

• Never connect or disconnect communication and/or power cables, while the camera system 
power is on. Damage to the CMOS detector or the camera electronics may occur if the cables 
are connected/disconnected while the power is on. 

• The camera system is fragile and care should be taken in order to prevent camera damage. 
The camera system must never be mishandled, hit, knocked or dropped. 

• The Faxitron Core System has a calibration mode. Calibration must be completed daily to 
ensure proper system function. Refer to Sections 5 and 6 of this manual for the Calibration 
Procedure. 

• Be sure the Specimen Drawer is fully closed before turning the unit off. 

• Be sure the Specimen Drawer is clean and free of specimens and/or any residue before 
turning the unit off. 

 

 4.0.0 
System 
Warnings & 
Precautions 
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Interoperable Connections 

The Faxitron Core system is capable of operating as a standalone device without any input or 
output to other devices. Images can be captured, stored and reviewed directly on the system. 

However, the system does come with several interfaces. The primary interface is the network 
connection which allows the system to be connected to a Picture Archiving and Communication 
System (PACS). Images can then be transmitted from the device directly to the facilities network 
via our software in a DICOM format. See Section 6 for details on DICOM version. Only Hologic 
employees or trained IT personnel at the user facility should set up this communication. 

The system’s connections and their intended use are listed below. No other type of devices 
should be connected to the Faxitron Core system without approval from Hologic. 

 4.0.0 Cont. 

Connection Purpose Device Type 
 

Intended User 

Ethernet port 
at rear 

To store radiographic images to 
networked data storage 
 

PACS or Network 
storage 

Set up by Hologic or facility IT 
personnel. Used by clinicians.   

Ethernet port 
at rear 

To allow remote connection by the 
Hologic service team, so Hologic 
can diagnose and repair the system.  

Network internet 
connection 

Hologic or facility IT personnel 

USB port at 
the front 

To transfer images from device.  
This should only be used if PACS or 
network is not available.   

USB storage device 
(Flash Drive) 

Clinicians or IT personnel with 
approved access to the system.   

USB port at 
the front 

To service and maintain the system 
files may need to be copied to and 
from the computer. For example, 
software updates or log files.   

USB storage device 
(Flash Drive) 

Hologic or facility IT personnel 

USB port at 
the rear 

To allow connection of a printer. 
Vision software allows for 
connection of a DICOM printer or a 
standard windows compatible 
printer.   

DICOM or windows 
printer 

Clinicians or facility IT personnel 

 
 
Cybersecurity 

Device security is a shared responsibility between Hologic and the health care facilities. Failure 
to maintain cybersecurity can result in compromised device functionality, loss of data (medical 
or personal) availability or integrity, or exposure of other connected devices or networks to 
security threats. Hologic maintains a set of cybersecurity controls to assure the cybersecurity 
of its units and to maintain their functionality and safety. 

All our units use standard Windows operating systems. At installation, we recommend the 
facility install all the necessary security measures as defined by their own internal requirements, 
as they would with any other PC connected to the network. 

The facility can set up the Windows operating system with all the network protocols and 
permissions necessary. For example, they can add: 

• User ID and passwords, 
• Layered authorization with appropriate authentication, 
• Restrictions on software installations, 
• Trusted content requirements, including code signature verification, 
• Set up windows updates including security releases. 
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In addition, our imaging software (Vision) can be password protected so certain users can get 
on to the operating system without being able to open the Vision software. 

The unit comes with a physical key that powers on the X-Ray system. This allows the system 
to be locked out so even if the software is accessed no x-rays can be initiated. 

This unit is designed to be used either as a standalone unit or connected to the Facility’s internal 
PACS or other closed-loop network. It is not intended to be connected to the internet unless, 
(a) the Facility is specifically instructed to do so by Hologic, or (b) the Facility takes adequate 
precautions to ensure the cybersecurity of the unit from threats related to its internet connection. 

Hologic will develop updates or patches for the Hologic software to continue to assure the 
products’ safety, as needed throughout the lifecycle of the unit. 

Additional security measures, including encryption, can be implemented and Hologic can work 
with the facilities IT department to reduce the risk to patients as a result of a cybersecurity 
breach. 
 
Cybersecurity Events 

If a cybersecurity event occurs disconnect the system from the network and contact Hologic 
immediately. We will work with your IT department to resolve the issue. 

A cybersecurity event can be detected in a number of ways: 

• Slower than normal operation and/or network connection, 
• Suspicious pop-ups or home page changed in internet browser, 
• Password(s) no longer working, 
• Unidentified programs in start menu or system tray, 
• Missing, corrupt or altered data. 

 
 
Cleaning 
Internal Chamber 

Samples containing biological specimens can harbour infectious agents that are hazardous to 
your health. Follow appropriate biosafety procedures; wear gloves when handling tissue 
specimens or any materials which they come in contact with. 

The only part of the x-ray chamber accessible for cleaning is the sample drawer. You may gently 
wipe down the sample drawer with a soft lint free cloth moistened with 70-90% isopropyl alcohol 
or diluted sodium hypochlorite (5-25%-6.15% household bleach diluted 1:500 provides the 
proper concentration.)  

• Do not use abrasives or harsh solvents. 
• Do not scrub the recessed image area of the drawer as this may scratch the surface 

and create image artifacts. 
• Test cleaning agents on small inconspicuous areas of the drawer to verify they will not 

damage the material 
 

External 

Periodically wipe down the exterior surfaces with isopropyl alcohol, sodium hypochlorite, or mild 
soap and water. (See above for appropriate concentrations.) Do not drench or flood surfaces 
and do not use abrasives which may scratch surfaces. Do not allow any moisture to contact 
any of the systems electrical components. Test cleaning agents on a small inconspicuous area 
of the covers to verify they will not damage the material. 

 4.0.0 Cont. 
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System Setup 

The Faxitron Core should be set up by a Hologic Inc. authorized representative. Contact Hologic 
at telephone number 1-800-447-1856 to confirm that the system has arrived and to arrange a 
time for system installation and setup. 

 
Inspecting the Boxes 

The Faxitron Core System arrives in one (1) cardboard box.  The box contains the Faxitron 
Core X-Ray Cabinet, the computer, the monitor, power cord, video cable, cables, cords, 
documentation, X-Ray Cabinet keys, and 25 sample trays.  

Have the shipping agent transport the box to an area where they can be kept safe from theft, 
damage, or environmental extremes until the Hologic Inc. authorized representative can install 
the system. 

Check the box for damage. If any damage is noted, contact Hologic at 1-800-447-1856. 

 

Lifting and Transporting the Boxes 

Caution: The box weighs approximately 80 pounds (36.3 kg). The box should be kept upright 
as indicated by the labels. Use caution when moving to prevent injury and damage 
to the system. 

 
Unpacking and Setting up the System 
The Faxitron Core system is to be unpacked and set up on site by a Hologic Inc. authorized 
representative. Please contact Hologic at 1-800-447-1856 when your system arrives to arrange 
for system setup. 

 

Location 

Leave at least 6” (15cm) of clear space behind the cabinet when installed to allow proper 
ventilation and access to the power cord and cables. 

 

Environmental Conditions 
Operational: 

Temperature:    15.5 to 30 degrees C or 60 to 86 degrees F.   

Relative humidity:    < 75 percent.   

Storage and transport: 

Temperature:   -20 to 50 degrees C or -4 to 122 degrees F.   

Relative humidity:   < 75 percent. 

The equipment is designed for the following conditions: 

• Indoor use, 
• Altitude to 2000 meters (6562 feet), 
• Pollution Degree 2, 
• Over-voltage Category II 

 4.1.0 
Faxitron Core 
Specimen  
System Setup 
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POWER REQUIREMENTS: 120 VAC 60 Hz 150W Max OR 240VAC 50 Hz 150W Max 

HEAT OUTPUT: 500 BTU/hr Max 

X-RAY DUTY CYCLE: 50% 

RADIATION SAFETY: Refer to Section 2 of this manual. 

 

The Faxitron Core was designed as a stationary system to be set up on a desktop, countertop, 
or table. 

Moving the Faxitron Core System - Not Recommended. 
Once placed at its final location it is recommended the Faxitron Core System not be moved. 

The Faxitron Core System is not designed to be a portable unit. Currently there is no cart 
provided, so the computer system will be placed on a non-portable surface as well. 

 

Caution: The Faxitron Core X-Ray Cabinet weighs approximately 40 lbs (18 kg) and is not 
designed to be lifted and carried. It is a precision instrument that needs to be handled 
appropriately. Do not try to lift or carry the system. 

Please do not block the area behind or immediately in front of the unit as this open space is 
needed for ventilation of the system and PC. There is adequate ventilation in the rear of the 
system as long as no objects are placed between the unit and the wall that contains the system's 
power receptacle. 

Ensure that there is a flat, level surface free of hazards in front of the system to enable personnel 
to safely access the specimen door, computer keyboard, monitor, and system control panel. 

 

Note: Allow enough space beside the system to easily access the system power cord. 

 

Caution:  If you must move the Faxitron Core System: 
• Ensure all components are fully powered down 
• Disconnect the power cords from the power receptacle 
• Disconnect all interconnecting cords and cables (i.e. Fiber optic cable) 
• Use care when moving the Faxitron Core X-Ray cabinet. 

 

Warning: The Faxitron Core System power cord is supplied with a grounded plug. If a suitable 
receptacle matching the system power cord plug is not available, enlist the services 
of qualified personnel to provide a suitable electrical receptacle. Do not attempt to 
modify the plug or receptacle yourself. 

 
 
Warning: To avoid damage to the unit and/or contact with infectious tissues, ensure that the 

Faxitron Core is thoroughly cleaned and properly packaged prior to removal from use 
for servicing, transportation, or disposal. 

 
 

 4.1.0 Cont. 
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Moving the 
Faxitron Core 
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System 
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Before powering up the system, please make sure that the power cords are securely plugged 
into the Faxitron Core cabinet, computer, and monitor before plugging the cords into the facilities 
mains power receptacles.  Also, if needed plug a Cat5 or Cat6 network cable into the Faxitron 
Core computer and facilities network connection. 

Refer to Section 4, Installation and Set-up, of this manual, and the Quick Set-up and Quick Start 
Guides provided with your Faxitron Core system. 

 
Basic Imaging Procedures 
 
Warning: Use of the Faxitron Core in a manner other than that described in this manual may 

result in impaired operation of the equipment or personal injury. 
 
Warning: Use approved containers or gloves in order to avoid contact with potentially 

hazardous patient tissue samples. 
 
Imaging Sequence Summary 
 
Refer to the Faxitron Core Quick Start Guide for a summary of system operation. 

• Open specimen drawer (press the black button). 
• Place the specimen(s) in a specimen container provided by Hologic, Inc. or your institution 

and place it inside the Faxitron Core drawer. 
• Close the specimen drawer (press the black button). 
• Choose or enter a patient in the Vision software and start an image acquisition from the 

software. 
• Press the Start (green) button on the Faxitron Core control panel or in the software. This will 

begin the X-ray exposure. 
• Wait until image is displayed. 
• Use the mouse to move the cursor over the displayed image and move cursor up and down 

for brightness/darkness levels or left and right for low/high contrast.  Move cursor until image 
is at desired level. 

• Repeat process for additional specimens. 

See Section 5.2 for more detailed operating instructions. 

See User’s Manual Section 6 for Advance Software Operation.   

 5.0.0 
Quick Start 
Overview 
 
 
 
 
Figure 5.0.1  
Faxitron Core Front Panel  
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General Start-up Information 

Power-Up (starting the system) is completed one-time at the start of system usage. It is 
recommended that once the Power-Up sequence has been performed; leave the system ON 
the rest of the day if planning to use it again. 
 

System Start-up Sequence Protocol 

Power Up System 

• Turn the computer and monitor “ON” and allow to fully boot into Windows. 

• Set the power switch on the back of the Faxitron Core cabinet to the 
“ON” position. See Figure 5.1.1. 

• Turn the key on the front of the Faxitron Core cabinet to “ON” 
(clockwise to the three o’clock position). See Figure 5.1.2. 

• Verify there is nothing in the Faxitron Core sample drawer. 

 

 

 

 

 

    

Start Software 

• “Double Click” the Vision Icon on the Windows desktop. 

• A Dialog box will appear briefly to indicate the software has 
initialized and is loading. 

• The software will open to the “Home Menu” or “Calibration” screen, 
depending on elapsed time since completion of the last calibration. 

The software will open to the Home Menu if a calibration has been completed within the last 12 
hours. 

To ensure optimum image quality Faxitron recommends calibrating the system upon initial start-
up each day or if the system has been moved.  

 

To manually start a calibration, click on the Calibrate button in the Home Menu, and then click 
on the Start Calibration button. The software will return to the Home Menu when calibration is 
complete. See Figures 5.1.4 and 5.1.5. 

 

 

 

 

 

 5.1.0 
Power Up 
Sequence  
 

5.1.1 
System Start Up  
 
 
 
Figure 5.1.1  
Main Power Switch  
 
 
 
 

Figure 5.1.2  
Key Switch 
 
 
 
 
 
 
 

Figure 5.1.3  
VISION Desktop Icon 
 
 

 

 

 

 

 

 
 
 

 

Figure 5.1.4  
Start Calibration Button 
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Calibrate 
NOTE: For optimum image quality it is recommended that the system be calibrated at least once 
a day, prior to first use. 
 

• The software will open to the Calibration screen if it has been 12 hours since the last 
calibration. 

• Press the Start Calibration button and allow the system to complete the calibration. 
 
 
 
 
 
 
 
 
 
 
 
 
 

• The Calibration Dialog box will open showing the calibration progress. 
 
 
 
 
 
 
 
 
 
 
 
• The Dialog box will close when the calibration is complete. The software will go to the 

Home Menu page.  

 5.1.2 
Calibration 
 
 
 
 
Figure 5.1.5  
Start Calibration Button 
 
 
 
 
 
 
 
 
 
 
Figure 5.1.6  
X-Ray Calibration Dialog Box 
 
 
 
 
 
 
 
 

 
 
Starting an Imaging Procedure 
• From the Home Menu page (See Figure 5.1.4) select the Start Procedure Button. 

• The user will be given options to Select from Worklist, Manual Entry, Select from Database 
or Continue with current patient. See Figure 5.2.1. 

 

 5.2.0 
Image Acquisition 
 
 
 
Figure 5.2.1 
Patient Data Entry buttons 
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• To manually enter a new procedure, select the Manual Entry button. 

NOTE: This section only covers “Manual Entry” of patient data, the remaining options are 
covered in Section 6 of this manual. 

•  The "Patient Information Editor" dialog box will open. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: Required Fields are indicated by a white asterisk (*). 
Default required fields are: Patient Name, Patient ID, Accession 
Number, and Laterality. 

 
• Enter all required fields. The Accept button will not be active if any required field is missing. 

The user may complete other fields as desired. 

 

Note: The Date must be entered as yyyy/mm/dd (e.g. 1962/08/13). 

 

• Select Accept to enable image acquisition. 

• The system is ready to acquire images. 

 5.2.1 
Entering Patient 
Data Manually 
 
 

Figure 5.2.2  
Imaging Information Editor 
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Taking an Image/Starting X-Ray Exposure 
To take an X-Ray image with the Faxitron Core system: 

• Open the X-Ray Chamber drawer by pushing the black button and place the Faxitron Core 
tray with the specimens in the drawer. Close the drawer by pressing the black button again.   

• Press the Green Start X-Ray button on the control panel or software. 

• Wait for the image to be displayed. 

 

 

 

 

 

 

 

 

 

 
 

 
 
 
NOTE:  Default X-ray mode for the Faxitron Core is Full Auto. The system will take two x-rays; 

the first to work out optimal settings and the second to take the image. The settings 
used during the exposures will be displayed on the cabinets LCD. 

 
The Vision software is configured to automatically save the image to the Faxitron database on 
the system computer’s local drive. The user can also save the image to the facilities server by 
clicking on the “PACS” icon. See Sections 6.4.1, 6.6.0 and 6.7.0 for more information on saving 
images. 
 
For more information on adjusting the image settings, X-ray controls, and reviewing and saving 
options, see Section 6. 

 5.2.2 
Starting Exposure 
 
 
 
 
 
 
Figure 5.2.3 
Faxitron Core Drawer 
 
 
 
 
 
 
 
 
 
 

 
 
Exit VISION Software 
Click on the Shut Down button, and then click OK" This will turn off the computer. Shut down 
can be selected on the home screen or image acquisition screen using the buttons shown below.  

 

Shut Down button from Acquisition screen. 

 

   Shut Down button from the Home Menu. 

    

Turn Off the Faxitron Core X-Ray Cabinet 
Once the computer is off, turn the key switch Off (key to vertical position). 

 5.2.3 
Shutting Down the 
System 
 
Figures 5.3.1 and  5.3.2 
Shutdown System and Exit 
Program buttons 
 
 

 

Drawer 
button 

X-Ray 
button 

On Screen 
“Start X-Ray” 

 



 

FAXITRON CORE USER MANUAL | HOLOGIC |  REVISION 043 

  6 

SECTION 6 
Vision Software 

Operation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
 
 
 



 
 
 

FAXITRON CORE USER MANUAL | HOLOGIC | REVISION 043                                      

SECTION 
Vision 
Software 6 

6 - 2 

Vision Software is a complete image acquisition and processing package, designed exclusively 
to work with Hologic X-Ray Generators (such as VersaVision, Faxitron Path, Faxitron Core and 
Faxitron OR Systems.) In addition to the acquisition and processing functions, the software 
offers an extensive database module, which allows user control, maintenance of image 
archiving, storage, filing and retrieval. The software is also Digital Imaging and Communications 
in Medicine (DICOM) compliant, allowing saving and printing of Patient images in DICOM format 
3.0. The software has been pre-installed on the computer that was packaged with your x-ray 
system. 
 
System calibration is required at the beginning of every new day of system use for best image 
quality. The system user may also perform calibration at any time to ensure optimum image 
quality. 
 
After calibration, the Home Menu will be displayed, which allows navigation to all other areas of 
the software. For ease of use, application buttons are provided. See Figure 6.0.1.  These 
buttons are in the center of the screen. Button descriptions and definitions are outlined, in the 
following sections of this manual.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sequence Protocol 
 
This start-up sequence must be followed to ensure proper system functionality and image 
quality: 

• Turn the Faxitron Core Cabinet power on using the switch on the back of the cabinet. (The 
power switch is next to the power cord receptacle). Depress “l” for “Power ON” and “0” for 
“Power OFF”. 

• Turn the Faxitron Core System “ON” by inserting the Faxitron Core key into the key lock 
switch, located on the front panel, and turning it clockwise to the 3 o’clock position. Note: the 
key cannot be removed in this position. 

• Turn on the computer and monitor. 

• Double click the left mouse button on the Vision Software icon (located 
on the Windows desktop) if Vision does not automatically start. See Figure 
6.1.1. A dialog box will briefly appear to indicate the software has initialized 
and is loading. 

• Vision software will open to the Home Menu (see Figure 6.0.1) or the 
Calibration page (see Figure 6.2.2) depending on elapsed time since the 
last system Calibration. 

• Refer to Section 6.2.0 “Camera Calibration Overview” for calibration protocols. 

 6.0.0 
Overview of Vision 
Software 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.0.1  
Vision Software  
Home Menu (Start-up Screen)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1.0 
Software Start-up  
 
 
 
 
 
 
 
 
 
Figure 6.1.1  
Vision Software Desktop Icon 
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Calibration Introduction 

 
To optimize image quality, Vision Software and the hardware requires periodic calibration.  This 
calibration requires the acquisition of reference images.   
 
Upon initial start-up of the system, or at any time desired by the user, a system calibration may 
be requested and performed.  It is recommended that after an elapsed time of twelve (12) hours, 
the following calibrations be performed. 
 
These reference calibration images are used to calibrate a "raw" X-Ray image, on a pixel-by-
pixel basis, to generate a "corrected" image for display.  Image corrections performed include 
gain, offset and linearity corrections. 
 

Calibration Sequence 
 
For convenience, Vision software combines the numerous steps of calibration, into a single 
unified step. 
 
When a Hologic X-Ray System has been turned off for longer than twelve (12) hours, the system 
will automatically request to re-calibrate. It is highly recommended that the system be re-
calibrated, after extended periods of inactivity, or after the system is moved from one room to 
another room, with potentially different ambient temperature/humidity settings.  
 
To calibrate the system at any time, click the Calibrate button on 
the Vision Home Menu (Start-up Screen) and then press Start 
Calibration.  See Figures 6.2.1 & 6.2.2. The Dialog will display a 
status message during calibration. See Figure 6.2.3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
During calibration, X-Rays may be generated. During X-Ray generation, a Stop X-Ray button 
will be made visible, to allow a user the option to stop X-Ray, through software. 

  
6.2.0 
Camera Calibration 
Overview 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.2.1  
Home Menu calibrate button 
 
 
 
 
 
 

Figure 6.2.2  
Start Calibration button 
 
 
 
 
 
 
 
 
 
 Figure 6.2.3  
Calibration Status 
 
 

 
 
 



 
 
 

FAXITRON CORE USER MANUAL | HOLOGIC | REVISION 043                                      

SECTION 
Vision 
Software 6 

6 - 4 

 

The following is a summary of the advanced calibration protocol, for "Both" (Flat Field and 
Image): 

Place the uniform attenuator on the detector. The entire detector surface should be covered by 
the attenuator. For ideal results, the attenuator should be larger than the detector's imaging 
area. 

From the Home Menu of the imaging software, press the top-right ^ icon to bring the menu into 
focus. Select the drop-down menu item "Tools", in the horizontal menu, located at the top of the 
screen, and then proceed to “Advanced Tools”, then to “X-Ray Calibration/Exposure Setup”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
NOTE: The kV, Exposure Time, and ADU/s values may vary from those shown. 

• Under "X-Ray Generator and Exposure Settings", enter the generator kV setting, in the 
appropriate field. 

• Leave "Magnification" at the default setting of 1.450. (The magnification is fixed in the Faxitron 
Core system) 

• Select the "Set for" "Both" button in the dialog box. 

• Leave the default "user ADU target" setting. X-Ray exposure will be terminated when the 
detector has accumulated a mean signal level of ADUs that are acceptable for the X-Ray 
generator you have. 

• Leave the default test exposure time and click on the Acquire button. The system will 
automatically begin X-Rays and obtain an image. 

• When the X-Ray exposure is complete, click on the Estimate/Calculate button. 

• Record the calculated exposure time "Time [s]" reading.  The system calculates this time, and 
the number is greyed out. 

• Enter the calculated exposure time reading “Time [s]” in the “Test Exposure” time box. Press 
the Acquire button to automatically begin X-Rays and obtain an image. 

• When the X-Ray exposure is complete, click on the Estimate/Calculate button. 

• Record the calculated exposure time “Time [s]” reading. 

• Enter the calculated exposure time reading in the “Test Exposure” time box once again. 

  
6.2.0 Cont. 
 
 
 
 
 
 

Figure 6.2.4  
X-Ray Generator and Exposure 
Dialog Box 

 



 
 
 

FAXITRON CORE USER MANUAL | HOLOGIC | REVISION 043                                      

SECTION 
Vision 
Software 6 

6 - 5 

 
• Click on the Accept Settings button. 

• Perform a standard calibration procedure, as described in the “Camera Calibration Overview” 
section. 

Experienced users may with wish to set the “X-Ray Cal (Flat-Field)" and "Manual Image" 
"Exposure Settings" independently, or "Both" (Flat-Field and Manual Image), as previously 
described.  By selecting the "Flat Field" radio button, the system will determine the optimum 
exposure time, for acquiring Flat Field images, at the desired ADU level.  Accordingly, the 
selection of "Manual Image" will determine the optimum exposure time, for the system with an 
object, which will attenuate the X-Ray signal.  For best results, the entire imaging area of the 
detector must be covered, by the object. 

After the selection of either "X-Ray Cal (Flat-Field)" and "Manual Image", the ADU level has 
been set; select the Acquire button.  For the "Manual Image" selection, it is desired to have the 
object or X-Ray attenuator, in the X-Ray beam. Press the Acquire button to generate X-Rays and 
obtain an image. When X-Ray exposure is complete, click on the Estimate/Calculate button.  
The system calculates optimum time, and the number is greyed out.  Click the Accept Setting 
button to save the "Exposure Settings" to the system's configuration file.   

Note: Only the settings for the selected radio button are saved.   

Next perform a standard calibration procedure, as described in the "Camera Calibration 
Overview" section. 

 

 

Occasionally it may be desirable to incorporate the X-Ray attenuation characteristics, of a 
uniform attenuator in the flat-field reference calibration images. For example, if all objects to be 
imaged are placed on a thin plastic plate, X-Ray attenuation characteristics of the plate will be 
observed, in every image acquired. In this case, placing the plate in the X-Ray beam, during 
flat-field reference calibration image acquisition, could improve image quality. 

 
 

The Start Procedure button (See Figure 6.0.1) takes the user to the Patient Data Entry page, 
which provides methods to enter patient data. If a Work List has not been configured, the option 
will be greyed out and only the Continue with Current Patient, Manual Entry, and Select 
from Database options will be accessible. The options are explained in the next sections. 
 

 6.2.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.2.1 
Advanced 
Calibration 
 
 
 
6.3.0 
Patient Data 
 
 
 
Figure 6.3.1 
Patient Data Entry screen 
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Select from Work List (Remote Modality Work list) 
If a Work List has been configured the user can click on the Select from Work List button which 
will display the page shown in Figure 6.3.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the left are various filters, which may be used to search for scheduled procedures for the 
Station Application Entity (AE).  Verify that the station AE Title is defined, then any single field or 
any combination of fields may be used as a filter to search for scheduled procedures, for this AE.  
By selecting the Query button, located in the bottom left corner, the table is re-populated with 
the entries, that match the queried information. 

The user can then single-click any entry and hit Submit to automatically populate the Imaging 
Information Editor with the patient information. 

NOTICE: The user may also double click any entry, within the table, to quickly go into the Imaging 
Information Editor without having to press Submit. 

The Imaging Information Editor (Patient Information Dialog) will open. See Figure 6.3.3. 
Complete remaining required fields and click on Accept to proceed to image acquisition. 

 6.3.1 
Select from Work 
List 
 
Figure 6.3.2 
Modality Worklist Search Dialog 

 
 
 

NOTE: All patient data is fictitious.  
Any resemblance to actual persons is 
strictly coincidence. 
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Note: Required Fields are indicated by a white 

asterisk (*). Default required fields are: 
Patient Name, Patient ID, Accession 
Number, and Laterality. 

 
The user must enter all required fields, prior to 
being able to select the Accept button. The 
user may also enter a Date, Referring 
Physician, Procedure Name, Sex, Technician, 
Position View, Body Part, and Study ID, if so 
desired.  The Procedure Name, Position View 
and Body Part are chosen by a drop-down 
menu. 
 
Note: The Date must be entered in the format: 

yyyy/mm/dd (e.g. 1962/08/13). Failure to 
enter a valid date may cause errors 
when attempting to retrieve images.   

 
Note: The "required fields" may be altered or 

deleted, depending on the application.  
Contact Faxitron support for further 
information. 

 
Select Accept to continue or Start a New 
Patient or Procedure, to return to the Patient 
Data Entry page. 

 6.3.1 Cont. 
 
Figure 6.3.3 
Imaging Information Editor 
 

 
 
 

 Continue with Current Patient 
 
Click on this button to continue the current patient procedure. The “Image Information Editor” 
will open. See Figure 6.3.3. Follow the above procedure and notes. 
 
 

 6.3.2 
Continue with 
Current Patient 

 
 
 

Manual Entry 
 
Click on this button to manually enter a new Procedure. The "Imaging Information Editor" will 
open. See Figure 6.3.3. Follow the above procedure and notes. 
 

 
 

 6.3.3 
Manual Entry 
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Select from Database 

 
 
Choosing the Select from Database button will display the following page. See Figure 6.3.4 
below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The user selects a patient from the table on the right side of the page and then clicks on the 
Accept button which opens the Image Information Editor. (Note: The user may also double 
click the entry in the table to open the Image Information Editor.) Then follow the procedure and 
notes on page 6-7. 

Note: Use the scroll bar at the bottom of the screen to view hidden patient information. 

Vision allows the user to narrow the patient list by entering specific information in the “Search 
Parameters” window on the left side of the page. Only those patients matching all search 
parameters will be displayed.  

 

  
6.3.4 
Select from 
Database 
 
Figure 6.3.4 
Selecting Patient From Local 
Database Entries 
 
 

 
 
 

NOTE: All patient data is fictitious.  
Any resemblance to actual persons is 
strictly coincidence. 
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If the user wishes to change or view the information after it has been input, but 
before an image has been taken, they may click on the Patient Data icon in the 
top left corner of the screen. See Figure 6.3.5. 

 

The Patient/Imaging Information Editing window will open. This editing window will be 
populated with all the information that was previously entered/selected. See Figure 6.3.6. Note: 
The Editing window will now include a Cancel button. 
 
The user can change or add information as 
desired then click on: 

• The Accept button to save the changes and 
continue to image acquisition, 

• The Cancel button to cancel changes and 
continue to image acquisition. The software 
will revert to the original patient information 
entered, or 

• The Start a New Patient or Procedure 
button which will return the user to the 
Patient Data Entry Screen. See Figure 6.3.1.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once the user clicks on the Accept button the system is ready for image acquisition/x-rays. 

X-rays are started by pressing the green Start button on the front of the Faxitron Core cabinet 
or clicking on the Start X-Ray button in the lower right corner of the screen. See Section 5.2.2, 
Starting Exposure. The system will take a short “sample” x-ray, or pre-shot (which is explained 
in Section 6.4.4) followed by a longer exposure to acquire the image. The software will process 
the image before it is displayed on the monitor screen. Once the image is displayed, buttons 
on the left and right side of the screen, covered throughout this section, will be enabled.  

 6.3.5 
Patient Data Icon 
Figure 6.3.5 
Patient Data Icon 
 
 
 
 
Figure 6.3.6 
Imaging Information Editor 
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The user may view, but not edit, the patient 
information after acquiring an image by clicking on 
the Patient Data icon shown in Figure 6.3.5. This will 
display a modified Patient Information dialog box as 
shown in Figure 6.3.7. This box provides two 
buttons: Close Dialog or Start a New Patient or 
Procedure. The user may view, but not edit, the 
patient information after acquiring an image by 
clicking on the Patient Data icon shown in Figure 
6.3.4. This will display a modified Patient Information 
dialog box as shown in Figure 6.3.7. This box 
provides two buttons: “Close Dialog” or “Start a New 
Patient or Procedure”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once an image is taken, the 
current image properties can be 
viewed by pressing the (i) icon 
in the top-right corner. See 
Figure 6.3.8. The Image 
Properties Dialog box will be 
displayed in the top-right corner 
of the image. The box is semi-
transparent to allow one to see 
what’s underneath the box. See 
Figure 6.3.9. 

 
 

  
6.3.5 Cont. 
 
Figure 6.3.7 
Patient Information Dialog after 
Image Acquisition 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.3.8 
Image Properties dialog 
 
 
 

Figure 6.3.9 
Image Properties  (View Only) 
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Vision software provides various tools and menus to control various image attributes or 
parameters, x-ray acquisition, image views, image tools, and DICOM settings/access. The most 
commonly used tools are in a Tool Bar. The Tool Bar and Menus are described in more detail 
in the following pages.  

 
Vision software provides single click access to a number a commonly used tools or functions 
with a vertical tool bar located on the left side of the screen. More detailed descriptions follow 
in the next pages. See Figure 6.4.1. 

 

 

View / Change Patient Information 
(See Section 6.3.5 and Figure 6.3.5) 
 
 

Enhance Image Icon 
 
 
 

Window Level and Contrast Tool 
 
 
 
Digital Zoom Tool 
 
 
 
Annotation Tools 
 
 
 

PACS Save 
 
 
 
PACS Print 
 
 
 
Exposure Control (Device Control Panel) 
 
 
 
Back to Main Menu 
 
 
 
Shut System Down 
 
 

 

  
6.4.0 
Tool Bar and Menus 
 
 
 
6.4.1 
Side Tool Bar 
 
 
 
 
Figure 6.4.1 
Side Tool Bar NOTES: 

 
The following tools are always active 
in the image acquisition page: 
• View/Change Patient Information 
• Exposure Control, 
• Back to Main Menu, and  
• Shut System Down 
 
The following tools will be disabled 
after patient data entry and will only 
be enabled after an x-ray image has 
been acquired: 
• Enhance Image, 
• Window Level and Contrast, 
• Digital Zoom, and 
• Annotation 
 
The PACS Save and PACS Print 
tools are only enabled after an x-ray 
image has been acquired and when 
the system is connected to a PACS 
network. 
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Enhance Image 

 
The button shown in Figure 6.4.2 will process the image on the display to emphasize the smaller 
details, such as micro-calcifications, and small masses in the image.  
 
 
 

The algorithm, commonly known as "Peripheral Equalization" or "Thickness Equalization" in 
advanced imaging, is applied to the whole image. In addition to this algorithm, Faxitron employs 
a second, internally developed algorithm called the "Calcification Emphasis" algorithm. This 
secondary algorithm was made, to bring out small details, in the image, and make them much 
easier to see, and analyze.  
 
Since Patient images constitute a more general category, in terms of possible geometries, and 
variety of thickness, there may be some challenging sample geometries, and the user should 
use this tool with care.  
 
The system will be idle (in Standby) during the processing, and once completed, the button will 
stay depressed/active. The user can undo the process, by pressing the button again. 
 
 
 
 
 
 
 
 
 

  
6.4.1 Cont. 
  
 
Figure 6.4.2  
Image Enhancement icon  
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Inverting, Window Level and Contrast Adjustment 
 
The button, shown in Figure 6.4.3, will open the Window Level and Contrast adjustment tool. 
This tool allows the user to adjust the image’s window level and contrast. The user may also 
restore the Original Contrast by pressing the Original Contrast button, or invert the image, by 
pressing the Invert button. Inverting flips the color scheme, from being predominantly black, to 
being predominantly white, or vice versa. See Figure 6.4.4 below. 
 
 
 
 
 
 
 
 
 
 
 
 
The user may also adjust the slider bar for desired image 
contrast by clicking on the bar and moving it up and down, or 
by clicking on either of the indicator arrows on the bar, to move 
the lower or upper window level limits. See Figure 6.4.3 
(Informally this is also known as "Window Leveling."). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
An example of inverting is shown below: 
 

 6.4.1 Cont. 
 
 
 
 
 
Figure 6.4.3 
Window Level and Contrast Tool 
Icon and Controls 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figures 6.4.4 
Example of inverting with the 
Window Level and Contrast tool 
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Dynamic Zoom Adjustment 

 
The Zoom Tool icon, Figure 6.4.5, will open the Zoom Adjustment tool. After opening this tool, 
the user may use the slider bar to adjust the zoom level or click the buttons to Fit to Specimen, 
Fit to Screen, or Zoom 1.0x (full resolution). See Figure 6.4.6. When the image has been 
zoomed in, panning is necessary to navigate around the image. A thumbnail dialog will appear 
in the top left corner of the screen. See Figure 6.4.7 below. Click and hold the left button over 
the image and move the mouse to move the image around in the main screen. 
 
Note that traditionally, this feature is also called "Pan View" and/or "Pan and Scan.” 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
The Fit to Specimen button will attempt to detect, and zoom in onto the 
specimen, to ensure that the specimen is in full view. If a specimen is 
not detected it will default to the previous mode (either “Fit to Screen” or 
“Zoom 1.0x”). 
 
Fit to screen, fits the image to the screen. 
 
Zoom 1.0x is traditionally called “Full Resolution”, as it brings the image 
to a 1-1 view, with the monitor resolution. 
 
 
 
 
 

Annotations 
 
The button shown in Figure 6.4.8 will open the annotation tools. These tools and 
their many features are discussed in further detail in Section 6.8.0. 
 

 6.4.1 Cont. 
 
 
 
 
 
 
 
 
 
Figure 6.4.5 
Zoom tool icon 
 
 
 
Figure 6.4.6 
Zoom Level Adjustment tool 
 
 
 
Figure 6.4.7 
Pan View example (left) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.8  
Annotations icon 
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PACS Store 

The button shown in Figure 6.4.9 will only function when the system is installed in a 
medical facility with a PACS network. To save your files locally please refer to 
section 6.7.0. 
 
 

PACS Print 
The button shown in Figure 6.4.10 will only function when the system is installed in 
a medical facility with a PACS network. For local printing please refer to section 
6.7.0. 
 
 

Device Control Panel 
The button shown in Figure 6.4.11 will open the Device Control Panel, which allows 
the device user the convenience of controlling the X-Ray system through the 
software. The user can easily select the Exposure Mode, X-Ray Tube kV setting, 
Exposure Time, and the number of images to acquire for Image Averaging (if 
desired), and initiate the X-Ray exposure. 
 
 
NOTE: The status, or availability, of the Exposure 
Settings is indicated by the up/down arrows adjacent to 
the setting. The arrows will be white for active settings 
and light blue for inactive settings. The Exposure 
Settings that are active is dependent on which 
Exposure Mode is selected. 
 
Figure 6.4.12 to the right shows Full Manual mode has 
been selected and the kV, Time and Image Averages 
are all active. The user can adjust each of these 
settings.  
 
 
 
 
 
 
Note that the mA setting in the Faxitron Core system is 
not adjustable via software and will always be inactive. 
 
 
 
 
 
 
When finished click on the Request X-Rays button to 
acquire an image, or the Set button to save the settings 
and close the Device Control Panel. 
 
If the Cancel button is clicked the Device Control Panel 
will close without saving any of the changes. 
 
 

  
6.4.1 Cont.  
 
Figure 6.4.9  
PACS Store icon  
 
 
 
Figure 6.4.10  
PACS Print icon  
 
 
 
 
Figure 6.4.11 
Device Control Panel Icon 
 
 
 
 
Figure 6.4.12 
Device Control Panel 
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Back to Procedure 

The button shown in Figure 6.4.13 exits the image acquisition mode and returns to 
the Home Menu screen. 

 

Shutdown 
The button, shown in Figure 6.4.14 will exit the software, and shut down the 
computer. 

 

 

Additional dialog notes 
When a dialog is opened, it is “docked” to the left side of the screen. If a user wishes to un-dock 
the dialog box, they may click the top-right “Pin” icon, to undock the dialog box, and be able to 
drag the box freely. The “pin” then turns into a “X” icon, allowing for quick closing. 

Users can also quickly navigate between the various dialogs by clicking through the left menu. 
By doing so, the left menu will quickly close, and open the applicable dialogs, as appropriate. 

 

 

 
Top Menu Bar 

The software provides access to “View”, “Tools”, “Image Tools”, “DICOM Utilities” and “Help” 
menus through a Top Menu Bar. See Figure 6.4.15.  The Top Menu Bar is hidden by default 
and is displayed by clicking on the Arrow button in the top right corner of the screen. See Figure 
6.4.16. The Arrow button with be black or white depending on the software page/screen 
background. Each menu item is covered in detail in the following pages. 

 
 

Note: The arrow will point down when the Top Menu Bar is hidden and 
will point up when it is display. 
 

 
View Menu 

The “View” Menu is located in the top Main Menu and contains the sub-menu items shown in 
Figure 6.4.17 below. Each of these options will be described in more detail in the following 
pages. 
 
 
 
 
 
 
 
 
 
 

  
6.4.1 Cont.  
 
Figure 6.4.13  
Back to Home Menu icon 
 
 
 

Figure 6.4.14 
Shutdown System Icon 
 
 
 
 
 
 
 
 
 
 
 

6.4.2 
Top Menu Bar 
 
 
 
 
 
Figure 6.4.15  
Top Menu Bar 

Figure 6.4.16  
Top Menu Bar buttons 
 
 
 
6.4.3 
View Menu 
 
 

Figure 6.4.17  
View Menu 
 
 

 



 
 
 

FAXITRON CORE USER MANUAL | HOLOGIC | REVISION 043                                      

SECTION 
Vision 
Software 6 

6 - 17 

 

Zoom Mode 
 

Normal 
Displays the acquired image in its native format. The native format for the Faxitron Core image 
fits within the monitors display area. The user may zoom in on the image if desired. Refer to  
Dynamic Zoom Adjustment in Section 6.4.1.   
 

Adjust Zoom 
This option is greyed out and is not available at this time. 
 

Fit to Sample 
This option adjusts the acquired image to best fit the specimen sample within the monitors 
display area. 

 
Fit All 

This option displays the entire acquired image, regardless of its native format. The Full 
Resolution option does not work in this view mode.  
 

Fit Width 
This option displays the acquired image across the available width of the entire display area. 
 

Fit Height 
This option displays the acquired image across the available height of the entire display area.  
 

Image Averages 
This option allows the user to adjust the number of image averages to be taken per an exposure. 
The available options are 1x, 2x, 4x or 8x shots. Default setting is 1x Shots. If the user selects 
2, 4 or 8 shots the software will acquire the number of images selected back to back with a 
single push of the Start button and average those images into a single image. 
 

Image Perspective 
This option allows the user to rotate the displayed image to 0, 90, 180 and 270 degrees in 
orientation. 
 

 6.4.3 Cont. 
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Grid Options 
When an image is displayed, either as an acquired image or a retrieved image from the 
database, the user may activate a grid.  Also allows the user to set grid spacing (pitch).  See 
example below. 

 
 

User Window Levels 
This allows the user to define up to three (3) pre-defined, user set Window Levels (WL).  First 
select the Window Level button and adjust the WL to the desired level.  From the “View” menu, 
select “User Window Levels”. Select “Record Current WL” as USER WL #1, #2 or #3.  The 
adjusted WL will be saved under the choice previously selected. 

Default Window Level 
The user has two choices of “Default Window Levels” (WL).  “Optimize for whole area”, which 
adjusts the WL for the entire image, or “Optimize for sample”, which adjusts the WL for under 
the sample area only. Additionally, there is an option to “Set Default Window Level”, which is 
used for all obtained images located here as well. This will set the default window level based 
off the image statistics and will need to be done for the un-enhanced and enhanced images 
separately. 

Default Aspect of Raw Files 
It helps importing/opening of previously saved image files with unknown file attributes or binary 
image data without any header information.  Since exact imager array size is not available from 
header of image data file, a closest fitting imager dimensions will be used to import/open such 
images based on width being larger or smaller than height (default aspect information). 

  Enhance Image (same as the Enhance Image button) 
Processes current Patient image and enhances visualization of the tissue located near the 
periphery of the sample. 

Sample Viewer 
Sample View toggles a webcam viewer to aid specimen alignment. A webcam cannot be added 
to the Faxitron Core system. 
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Figure 6.4.18 
Sample grid display 
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Magnifier Size 

Allows the user to select the size of the Magnifier tool (see the Image Tools menu). The options 
are “Small”, “Medium” and “Large”.   

Review Layout 
Helps user configure multiple image panes in the Review (Database) Mode of program. 
Available options are; “(1 X 1) Single”, “(2 X 1) Double H”, “(1 X 2) Double V”, “(1 + (2 X 1) Triple” 
and “(2 X 2) Quadruple” layout. During multiple pane operation, the user can click on desired 
pane/image once, to make it current selection, the current selected pane will get a green 
rectangular border around. The images in database list view, or database thumbnail view, will 
be opened into current selected pane, when double clicked on them. User can also open the 
images into desired panes directly from right click menu of the mentioned database views. After 
right click menu is activated the user can select from the panes listed under OPEN TO→ which 
will provide available panes, to open the image into (left, right, top, bottom etc). 

 
 
 

Tools Menu 
The “Tools” menu is located in the Top Menu Bar, found in the upper left hand corner of the 
main screen. 

 
 
 

Preferences 
The “Preferences” menu opens a configuration management utility which can be used to change 
various options or parameters.  

NOTE: The “Preferences” tool option is password protected and should only be accessed by an 
authorized Hologic service representative. 

NOTE: Changing configuration parameters without proper knowledge or authorization can 
cause loss of image quality, system damage, and system malfunction. 

Service Mode 
“Service Mode” is password protected and turned on by Hologic authorized technicians for 
troubleshooting purposes.   

Service Tools 
“Service Tools” is normally greyed out. It is only turned on when the system is in “Service Mode”. 
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6.4.4 
Tools Menu 
 
 
Figure 6.4.19  
Tools menu 
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Save Reference Files 

“Save Reference Files” is normally greyed out. It is only turned on when the system is in “Service 
Mode”. 

 
 

Advanced Tools Options 
“Advanced Tools” offer various options to configure aspects of the software such as post-
processing and configuration options. 
 

Auto Save On/Off 
When “Auto save” is "on" all subsequently acquired images are saved to the database. The files 
are written to a Data Directory defined in the configuration file. 
 

X-Ray Calibration/Exposure Set-up 
This is placed under Advanced Tools. The “X-Ray Calibration/Exposure Setup” aids the user in 
determining the proper exposure time for a selected kV setting for best image quality. Please 
refer to section 6.2.0 and Figure 6.2.4 for a more detailed description. 
 

Preshot AEC Exposure Setup 
The Faxitron Core system utilizes Automatic Exposure Control (AEC) to provide the best 
possible image quality with a single press of the Start X-Ray button. The software utilizes a 
Preshot exposure to calculate the optimal exposure kV and time settings. The Preshot is a short, 
typically 2-3 seconds, x-ray exposure. The software analyses the results to determine the kV 
and time needed to produce the best image quality. The Preshot AEC Exposure is configured 
at the factory and is turned on by default.  

“Preshot AEC Exposure Setup” allows the user to adjust the system for particular imaging 
requirements or to compensate for system aging. 
To access the “Preshot AEC Exposure Setup” dialog go to the Top Menu Bar, select “Tools”, 
“Advanced Tools” then “PRESHOT AEC Exposure Setup”. See Figure 6.4.19. The Preshot AEC 
Settings dialog box shown in Figure 6.4.20 will open. 
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Enter the PRESHOT AEC values in the window shown at right. 

The settings shown reflect a 
23 kV and 2 second exposure 
time with a target intensity of 
8000 ADUs for the pre-shot 
setting. Users can enter pre-
shot parameters only when 
DYNAMIC METHOD (in the 
PRESHOT ANALYSYS 
METHOD section) is selected. 
The STATIC METHOD 
selection will use Hologic 
predefined parameters. In 
addition, the user has the 
option of selecting the kV, and 
exposure time settings, from 
the EXPOSURE TUNING 
METHOD section.  

For more accurate images the 
user can enter the SOFT 
TISSUE (Sample) thickness 
and the TARGET INTENSITY 
in ADUs.  

Note: The values shown are 
within the typical range for a 
Faxitron Core system but may 
vary. 

For the AUTOMATIC 
EXPOSURE CONTROL 
mode, push the Start button, 
within the Vision software (or 
on the Control Panel). The 
Vision software will perform a 
pre-shot (a short, low dose, pre-exposure) of the sample to create a Region of Interest (ROI) 
for obtaining the exposure parameters for the optimum image exposure. 

Login Utility 
The Login Utility is under the “Advanced Tools” menu and allows the user to configure and 
activate the start-up password authentication for Vision software. Activation of this feature is 
optional on the Faxitron Core system. If the user activates password authentication they will be 
prompted for the password each time 
the program is opened. The program 
will close if the correct password is not 
entered. 
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Figure 6.4.20 
Preshot AEC Exposure Setup  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.21 
Login Utility 
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Properties 

“Properties” hides or shows the Image Information Box. See Figure 6.3.9. 

Edit Current Image Record 
Currently not used. 

Delete Current Image Record 
Deletes the current image from the file directory, as specified in the configuration file. 

Add Current Image Record 
Adds the current image to the file directory, as specified in the configuration file. 

Capture Screen Shot JPG/BMP 
By selecting this menu choice, the user can do a screen capture of the displayed active window.  
The user can specify a file name and choose between JPG and BMP as the saved file format. 

Save / Store Current Image 
The user may "browse" to the directory or file folder to which the image is to be saved.  A file 
name must be assigned in the field provided.  The user may save the image as a BMP, JPEG, 
TIF, RAW Data, or DICOM file type. To save the file in a DICOM format, please refer to the 
"DICOM Functionality" section. 

Print Current Image 
Prints current image to Windows printer. 

 

  Image Tools 
The following features are available to edit the acquired or retrieved image by clicking on the 
“Image Tools” menu. See Figure 6.4.22. The sub-menu options are activated or accessed with 
a single mouse click on the desired option. 
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6.4.5 
Image Tools 
 
 
Figure 6.4.22 
Image Tools Menu 
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Original Contrast 

“Original Contrast” restores the image contrast levels. This serves the same purpose as the 
Original Contrast button in the Window Level and Contrast tool. See Section 6.4.1 and Figure 
6.4.3. 

Invert 
“Invert” causes the displayed image to become inverted or reversed. Inverting an image 
reverses its transparency: what is black becomes white, and what is white becomes black. 
Greys are assigned their mirror transparency. Click “Invert” again to turn off the feature. 
Performs the same function as the Invert button. Refer to Section 6.4.1 and Figures 6.4.3 and 
6.4.4. 

Magnify 
“Magnify” allows the user to magnify an area of interest.  To use the Magnify feature place the 
mouse cursor over the desired area to be magnified and click the left mouse button.  The area 
of interest will be magnified. Click “Magnify” again to turn off the feature. Refer to Figure 6.4.23. 
The size of the magnified area of interest can be adjusted by the user. Refer to the “Magnifier 
Size” sub-menu in Section 6.4.3.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edge Enhance 
“Edge Enhance” will create a sharper definition around edges of regions with a contrast 
difference. Edge Enhancement may amplify the noise in the images in general. Selecting the 
menu item again will turn off the edge enhancement. Clicking on “Original Contrast” will also 
restore the image back to its original state. Note this is a different feature than the Enhance 
Image feature in Sections 6.4.1 and 6.4.3. 

ROI Contrast 
“ROI Contrast” will optimize the contrast levels within a user-defined region of interest (ROI).  
After selecting “ROI Contrast” click and hold the left mouse button at the starting point of the 
desired ROI, drag the mouse, and release the mouse button at the desired ending point of the 
ROI. The contrast will automatically adjust to the best levels for that ROI. 

ROI Window Level 
The “ROI Window Level” function is not available in the current version of Vision software. 
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Figure 6.4.23 
Magnify 
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Ruler 

“Ruler” allows the user to measure the distance between two points in the displayed image.  
Length measurements are in millimetres (mm). After selecting “Ruler” click and hold the left 
mouse button, starting at the beginning point of measurement, drag the mouse and release the 
mouse button at the ending point of measurement. The Ruler is displayed as a red line on the 
image. 
 
The measurement (in mm) is 
displayed at the end of the Ruler. 
The Ruler remains active until the 
user selects another image tool 
or until another action is 
performed. See Figure 6.4.24. 
Click “Ruler” again to turn off the 
feature. 
 
Hint: To get a perfectly 
horizontal, vertical or 45-degree 
ruler, hold down the SHIFT key 
(on the keyboard), while holding 
down the left-mouse button, and 
drag. 
 
 
 
 

ROI Statistics 
“ROI Statistics” will display a dialog box containing image statistics. Click and hold the left mouse 
button over main image's region-of-interest (ROI), drag the cursor to make selection around 
area, and then release the mouse button. Statistical information for the selected region will be 
displayed on the left side of the dialog box and for the whole image on the right side of the box. 
The stats displayed are; The beginning and end points of the ROI, Minimum, Maximum and 
Mean intensity values, and Standard Deviation (STD).  To close the Statistics information box 
simply click on the Close button. See Figure 6.4.25. Click “ROI Statistics” again to turn off the 
feature. 
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Figure 6.4.24 
Ruler 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.25 
ROI Statistics 
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ROI Histogram 

“ROI Histogram” will create a histogram for a user defined ROI. After selecting the menu item, 
place the mouse cursor in the displayed image, press and hold down the left mouse button, 
and drag the cursor to make the desired ROI selection.  Release the mouse button.  
Histograms for the selected ROI will be displayed. See Figure 6.4.26. 

The Black curve is the Histogram of the selected region. The Blue curve is the Histogram of 
the whole image. Both curves are normalized against the peak maximum pixel value of the 
selected region of interest. Click “ROI Histogram” again to turn off the feature. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ROI Profile 
“ROI Profile” will create a profile for a user defined ROI. After selecting the menu item place 
the cursor in the displayed image. Hold down the left mouse button and move the cursor 
across the image to draw a user-defined box around the desired ROI.  Release the left mouse 
button and a profile will be displayed showing the individual pixel values of the defined ROI. 
See Figure 6.4.27.  By default, the averaging direction of the selected ROI is the short axis.  
The axis may be toggled back and forth by selecting the SWITCH, HOR<->VERT button. 
Click “ROI Profile” again to turn off the feature. 
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Figure 6.4.26 
ROI Histogram 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.27 
ROI Profile 
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Line Profile 
“Line Profile” will display a profile for a user defined line. After selecting “Line Profile” place 
the cursor in the displayed image. Hold down the left mouse button and move the cursor 
across the image to draw a user-defined line. Release the left mouse button and a profile will 
be given showing the individual pixel values of the defined line. See Figure 6.4.28.  By default 
the first selected point is always the left most (near origin) portion of the plot (i.e. horizontal 
axis of the graph can have increasing or decreasing pixel (i,j) indexes, depending on the 
selected start/end points).  Click “Line Profile” again to turn off the feature. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Built-In Window Level 
Vision Software comes with a “built-in” Window Level feature. There is no button or menu 
item to select it. The Window Level feature is automatically activated whenever an image is 
acquired or retrieved from the database for review. This feature gives the user the ability to 
adjust the image contrast and brightness levels using the mouse/cursor. 

Click and hold the left mouse button over the displayed image and move the cursor up and 
down for brightness/darkness levels. Or, move the cursor left and right for low/high contrast. 
Move the cursor until image is at desired levels. 

 

 6.4.5 Cont. 
 
 
 
 
 
 
Figure 6.4.28 
Line Profile 
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By pressing the button shown in Figure 6.5.1, located along the bottom of the image 
acquisition window, the current patient images thumbnail strip appears. See Figure 6.5.2. 
 
 
 
 
 
 
 

 
 

 

The thumbnail strip displays the Procedure date for each individual image series in orange 
text along the top. 

The current image displayed in the image acquisition window will be highlighted in green. 

The thumbnail strip supports drag and drop operations to place images into the image display 
or review panes as necessary. 

In addition, with a single click, the user can select multiple images and then select from the 
various options to Save the images to a USB drive, send the images to PACS, or delete the 
images. Selected images are highlighted in orange. 

There are arrows located to the left and to the right. In the event of many images being taken, 
the user may traverse the images taken, date ascending, by pressing on the left/right arrows. 

There is also an option available to Open the Database (see Figure 6.5.3), which enters 
Review mode. This same button is the equivalent of pressing Review Mode, from the Home 
Menu. See Figure 6.0.1 and 6.6.1. 

 

 6.5.0 
Current Patient 
Images Browser 
Figure 6.5.1 
Current Patient Images 
Browser icon 
 

Figure 6.5.2 
Current Patient Images 
Browesr 
 
 
 
 
 
Figure 6.5.3 
Image Database button 
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Review mode can be entered by clicking the Review button in the Home Menu page, Figures 
6.6.1 and 6.0.1, or the Open Database button in the Current Image 
Browser. See Figure 6.5.3 above. Clicking either of these buttons will 
open the Database as shown in Figure 6.6.2. The system will be in 
Standby while in review mode.   
 
 
 
 
The Database is basically comprised of three sections, or sub-windows. The Patient List 
Table section, at the top, the Procedure List Table section, in the middle, and the Image 
Thumbnail List/Viewer section, located at the bottom.  

 

 6.6.0 
Database  
Figure 6.6.1  
The Review Mode icon 
displayed on the Home Menu  
 
 
 
 
 
 
Figure 6.6.2 
Image Database 
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The list tables work in top-to-down hierarchy as indicated by the arrow: 

The Patient List--->Procedure List--->Image Thumbnail List/Viewer. 

When a Patient field is selected, the Procedure window becomes active. The Procedure 
window displays a listing of all Procedures performed under the selected Patient. Additionally, 
all images corresponding to the patient are displayed in the bottom right.  

When a Procedure is selected, the image thumbnail list/viewer is filtered to only show the 
images which correspond to the selected procedure. Multiple procedures can be selected by 
holding the Shift key and left-clicking each procedure. All the images for selected procedures 
will be displayed accordingly. 

The database may have its sorting adjusted by clicking on the top fields such as Patient ID and 
Last Name to sort by either one. When the mouse cursor is clicked over one of the database 
fields, a small arrow indicator is displayed within the field. Using the Left Mouse button and 
selecting the field again changes the arrow from ascending to descending or vice versa. The 
field selected will be automatically sorted accordingly. 

Scroll bars are located in the database to allow for ease of navigation. 

The thumbnail list/viewer allows for a user to click on the “+” symbol to automatically add the 
image to a review pane. A user may add up to four images into the review panes. The review 
panes are automatically adjusted to encompass the four images. 

All the options from the Current Patient Images Browser (see Figure 6.5.2) are also available 
at the top of the Database page. Also, additional options are described in section 6.6.1. 

Important Note: The "thumbnail" images (.PNG) are separate files from the actual image data 
(DCM, DAT, DMM or RAW) files.  They have the same file name as the image file, but they 
have a (.PNG) file extension.  It is possible to have an image file and no "thumbnail". In that 
event, Vision will attempt to create a thumbnail automatically for the image to be loaded into 
the database. However, if this is unsuccessful, the image will not be displayed. 

 
Save Image(s) 

The Save Image(s) button is available when an entry from the Image Table or Thumbnail List 
is selected, or through the current patient images, otherwise it is disabled. The selected image 
can be saved in the following popular 8-bit image formats: JPEG, BMP, TIFF and RAW. It can 
also be saved in 16-bit TIFF format. 

The window level of the saved image is the default window level. If the user requires that the 
window level be arranged, he/she should load the image to the Image View and print from there 
rather than printing from database dialog. 

 

Send Image(s) to PACS: 
This function sends the image(s) to a pre-configured DICOM PACS Server. Please refer to 
Section 6.7.0 for more information.  

 
Image Database Menu Functions and Tools 

There are functions to navigate, search in the database, and 
to edit, delete, and add records to the database. Those 
functions are explained through database menu items. They 
are accessed from the top-level button labelled Additional 
Options within the database. 
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6.6.1 
Database Additional 
Options 
 
Figure 6.6.3 
Additonal Options Menu 
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Open Menu 
The “Open” Menu has only one option “Open Image from File” which opens a Windows dialog 
box that allows the user to navigate to and open image files located on local or network 
drives. 

Print Menu 
The “DB-Print” menu provides for Image/Procedure/Patient print functionality. See Figure 6.6.4. 

 

 

 

 

 

 

Print Image to Local Printer 
“Print Image to Local Printer” is available when entry from the Image Table or Thumbnail List 
is selected, otherwise it is disabled. The selected image will be printed using the local default 
printer of Windows system. 

The window level of the printed image is the default window level. It is not recommended that 
users Print from this menu, unless they are satisfied with the print outs set to the default window 
levels as calculated by the program.  The user can load the image first into the Image View 
(Review) window, and then adjust the image to the desired window levels.  When satisfied with 
the window level, the user can then initiate Print from the menu of Image View window.  A 
Format Options dialog provides a choice between printing formats. 

Print Image(s) to DCM Printer 
This function sends the image(s) to a pre-configured DICOM printer. 

View Menu 
The “View” Menu provides the user a number of options affecting the Database view. See 
Figure 6.6.5. 

 
 
 
 
 
 
 
 
 
 

Show All DB Entries 
Reloads the Patient table from the Database file.  Any new changes or additions to the 
Database will be applied to the table.  This selection also clears any active Search Filter which 
may have been applied to the tables.  Search Filter is explained in detail under the Database 
Search subject below. 

Refresh DB Entries 
Refreshes the Patient table, but maintains any existing Search Filter that has been applied. 
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Figure 6.6.4 
Database Print Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.6.5 
Database View Menu 
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Browse Data Directory (No DB) 
Displays all thumbnail images, in the Data directory established by the configuration file. These 
files are displayed in the Thumbnail Viewer. They are not associated with the Database or table 
lists. This tool is helpful to review un-recorded images, or debug database problems with 
images in the current data directory. 

Browse Any Directory (No DB) 
Allows user to browse to any file directory.  These files are displayed in the Thumbnail Viewer. 
They are not associated with the Database or table lists.  This tool is helpful to review an image 
directory, which was never recorded in the database, or when database records are corrupted. 

 

Search Menu 
The database “Search” tools, see Figure 6.6.6, provide detailed searches, or database filtering. 
Selecting the “DB-Search” menu allows the user to perform a detailed and specific search. 
When search criteria is entered and activated in the DB Search Dialog, see Figure 6.6.7, the 
search filter is applied to all list tables in the Image Database dialog. The activated search 
criterion is called Search Filter and this filter remains effective until the user selects “Stop 
Search” from the “DB-Search” menu, or “Show all DB Entries” from the “DB-View” menu. The 
active Search Filter is always shown in the caption of Image Database dialog. 

 
 
 
 
 

Start Search 
“Start Search” opens the DB Search Dialog which allows the user to place an active SEARCH 
FILTER on the database. When the Search Dialog is opened, the Database page is closed and 
the software goes back to the Image Acquisition page. The Database page will reopen 
automatically after the Search Dialog is closed. 

 
 
 
 
 

Drop down menus provide a listing of the search categories.  Select a search category and type 
in the desired search parameter to start the search.  Select “Start”  to initiate the search.  If the 
category can have more than one discrete entry, all entries for that category will be displayed. 

Stop Search 
“Stop Search” disables any active Search Filter, clears all list tables, and re-loads the list of all 
Patients to Patient List Table 
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Figure 6.6.6 
Database Search Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.6.7 
Starting a Database Search 
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Tools Menu 

The “DB-Tools” menu provides for Image/Procedure/Patient functions, as well as some useful 
functions to repair or reformat the database. 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Image Record 
The “Edit Image Record” function is not currently available in Vision software. 

Add Record to DB 
Available when entry from Image Table or Thumbnail List is selected, otherwise disabled. This 
is especially useful when a directory is browsed, without database having entries available for 
images in that directory. The user can select a single image from the thumbnail list and add 
records of that image into the database.  If the database entry already exists for the selected 
image, it will not do any harm, it may only update the database, in terms of where the image 
file is currently located, i.e. file/folder name.  

Import Records in DIR to DB 
This tool helps to browse and select a folder, and then populate the database with all the 
corresponding entries for all the image files under the selected directory (including 
subdirectories).  The formats for images can be DCM, DAT, DMM and RAW.  If thumbnails of 
images are missing, this tool will also generate BMP thumbnails, in the same directory. 

Reformat All DB 
“Reformat All DB” tool helps to reformat Date [YYYY/MM/DD], Date/Time [YYYY/MM/DD 
HH:MM:SS] fields of tables, and also capitalizes letters of entries for some other fields. It is a 
useful tool when some older database file is imported, and opened for the first time, or when 
the user alters database entries manually using MS Access. 

 
 

Additional Notes on the Database 
• The ability to Exit the database, staying within the Review mode, is located under Additional 

Options.  

• The top-left button will adjust itself to take the user Back to Acquisition, Back to the Main 
Menu, or will become the Close Database button dependent on the workflow used to enter 
the Database screen, and what is most appropriate. 

 6.6.1 Cont. 
 
 
Figure 6.6.8 
Database Tools Menu 
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Edit or Delete Patient Information from the Database 
The user may edit or delete patient information from within the database. Right click on the 
patient’s entry in the top section of the database to open a Dialog box. See Figure 6.6.9.  

 

Clicking on “Edit Patient Information” will open a 
“Patient Information” dialog box. See Figure 
6.6.10. Click Cancel to return to the database 
without making or saving changes. Clicking Save 
Changes will open a “Confirmation” Dialog box. 
Click Yes to confirm and proceed. Changes are 
now saved and the user will be returned to the database. No will void the changes and return 
to the database. Cancel will return the user to the “Patient Information” dialog.   

Note: If the system has a start-up password activated (see the Login Utility topic in Section 
6.4.4 and Figure 6.4.21), the same password will be requested when trying to “Delete Patient 
Information” from the database. 
 

The DICOM Standard 
What is the DICOM Standard? 

The Digital Imaging and Communications in Medicine (DICOM) Standard is a series of protocols 
used by medical equipment and software, to allow data to be compatible and interchangeable 
with other medical equipment or software. 

When a file is saved in a DICOM format, a file is created that includes relevant Patient data, 
imaging equipment, hardware data, and image data, all in a single file.  Additionally, the saved 
file contains specific characteristics that identify it to computer and software as a DICOM 
Standard file.  Once a software application recognizes the file as a DICOM Standard file it can 
initiate a DICOM reader and extract the data properly, regardless of the file's origin. 

A file created using the DICOM protocol has the following structure: 

Where the Preamble consists of 128 bytes, all typically set to 00H unless it is not use by an 
Application Profile or a specific implementation; the Prefix consists of 4 bytes, making up the 
character string "DICM" encoded as uppercase characters of the ISO 8859 G0 Character 
Repertoire; and the Data Elements are arbitrarily large (or small) and contain the data. 

 6.6.1 Cont. 
 
 
Figure 6.6.9 
Edit/Delete Dialog Box (Left) 
 
Figure 6.6.10 
Patient Information (Right) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.7.0 
DICOM 
Functionality 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.1 
DICOM Protocol Structure 
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Modality 

The DICOM file settings for Modality are accessed from the Top Menu Bar by selecting  “DICOM 
Utilites”, then “DICOM Modality Setup”. 
 
 
 
 
 
 
The DICOM storage type, either Presentation or Processing may be selected.  The same Dialog 
box allows for selecting the DICOM Image Modality, either Digital X-Ray or Digital X-Ray 
Mammography.  The Transfer Syntax and Value Representation are not user definable.  They 
are always assigned to be META HEADER PRESENT, LITTLE_ENDIAN and VR_IMPLICIT. 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE: Once the DICOM Modalities have been selected, they remain in effect even after the 

Vision software has been closed.  The Modality settings are stored and will remain in 
the configured manner until they are changed again using the DICOM File Settings.  
These settings (Storage Type & Modality, Transfer Syntax, and Value Representation) 
will be effective for all DICOM Local Save or Print functionalities. 

  
6.7.0 Cont. 
 
 
 
Figure 6.7.2 
DICOM Utilities menu 
 
 
 
 
 
 
 
 

Figure 6.7.3 
DICOM Modality Settings 
Default settings shown 
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Default DICOM Servers 
This section contains settings for default DICOM servers and to automate some of the 
processes when storing, printing or searching PACS and MWL servers. 

“Enable Single-Click Auto Store”, “Print” or “MWL Connection” checkboxes allow user to store 
or print images or automatically connect to the MWL server.  If you use a single PACS server 
for those actions or majority of your work involves a single PACS server, check a desired box 
to automate those actions. 

“Enable Auto Search When Connecting to MWL Server” will tell the application to automatically 
perform a search with default search settings when looking up patient’s data. 

“Auto close dialog after N seconds of successful transfer/printing” will automatically close the 
DICOM Networking dialog after specified number of seconds passed.  The dialog will not close 
automatically if there was an error with transfer or printing. 

Clicking the DICOM Servers button will open DICOM Networking dialog, where a user can add, 
modify or delete DICOM servers. See Figure 6.7.5. 

DICOM Save Local 
To save the current image to a local drive/directory, right click anywhere in the image. This will 
display the dialog box shown in Figure 6.7.4 below. Click “Save/Store current image” then “As 
local DICOM image”. This will bring up the standard Windows File Save dialog. Browse or click 
through to the desired directory/folder, enter the file name and click Save. 

 

 

 

 

 

 

PACS Store and PACS Print 
The Vision software allows for PACS (DICOM) Store and PACS (DICOM) Printing.  These 
options are available throughout the software. For example, if the PACS Store button is 
selected, the following DICOM Networking Dialog window can be displayed. This Dialog box 
allows the user to do 
a DICOM Store, 
DICOM Print, or to 
Add, Modify or 
Remove DICOM 
Network connections 
or Peripherals. 
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Figure 6.7.4 
Save Current Image Dialog 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.5 
DICOM Networking Dialog box 
 
 

 



 
 
 

FAXITRON CORE USER MANUAL | HOLOGIC | REVISION 043                                      

SECTION 
Vision 
Software 6 

6 - 36 

PACS DICOM Store 
The Vision software supports DICOM 3.0 C-STORE Service.  This allows for sending an image 
or a series of images (under a specified Procedure) to a remote DICOM Application Entity (AE) 
compliant storage system such as PACS.  Again, the DICOM Store capability is provided for 
throughout the Vision software.  Modifications to the Presentation and Processing may be made 
through the DICOM Modality Setup, under the Tools menu.   

Note: For DICOM Store, the "SET FILM Attributes" will be grayed out. 

The user can add a new configuration for a remote DICOM AE to which to send the image or 
select from an already configured one, shown under the DICOM Network connections, in the 
DICOM Networking Dialog. By double clicking (or single click, followed by pressing the Connect 
button) the icon for the remote DICOM AE, the Vision software will connect and establish a 
DICOM association with the selected remote AE. Once the association is successfully 
established, the image can be sent for storage by pressing the Store button. After the Store 
button is selected, the Vision software will send the selected image to the defined remote 
DICOM AE.  If the Store operation is successful, the remote DICOM AE will send a confirmation 
of reception and storage of the image(s).  If the operation fails, the remote DICOM AE will send 
an error code indicating the reason for failure. 

A single image can also be sent for storage by clicking the Right Mouse button on the image 
"thumbnail" while in the Database Browser and following the same procedure described 
previously. It is possible to send a whole Series (Procedure) of images for storage. This is 
accomplished by clicking the Right Mouse button on the Series (Procedure) name, displayed in 
the Database Browser screen and again, following the same protocol described above. 

 

Add Session 
The Add Session button opens the Session Dialog box through which the user can configure 
a new connection to a remote DICOM Application Entity.   

To create a new connection configuration to a remote DICOM AE, the user must have the 
following information available: the Application Entity Title (AE Title), the choice of DICOM / 
PACS "function to perform", the IP Address and the Port Number for the Sever (i.e. the DICOM 
printer or PACS system).   

The AE Title and Port Number of the user's system (i.e. the client) are also required. Complete 
the appropriate data fields and select OK to create a new configuration. 

 

Choosing DICOM / PACS Default Session Function Behavior 
There are currently four (4) types of functions which a DICOM session can represent as a 
default. These are found in the Function drop-down list (combo box) seen in Figure 6.7.6 below. 
A list also follows: 

1. A GENERAL DICOM / PACS Connection 

2. A DICOM STORE Connection 

3. A DICOM PRINTER Connection 

4. A DICOM Modality WORKLIST 
Connection 

 

 6.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.6 
Session Properties Dialog box 
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The purpose of the DICOM "Function" is to allow a Session/Connection to be created (added) 
that allows a DICOM / PACS "device" to only be used, as the user has configured it, for a 
particular function category. Once configured, when you view or use the "DICOM Networking 
Dialog" (see figure 6.7.5), only the icon that matches the function chosen will be "active and 
lit up." That is, it will have a blue color as opposed to a "grayed out" color. For example, in 
figure 6.7.5 there are three (3) icons representing in order: a PACS Store (DICOM Store 1), 
a PACS Print (DICOM Print 1), and a Modality Worklist (DICOM-MWL). Because the DICOM 
Store icon was chosen previously it is the only one active (blue screen. It works the same for 
the other modes as well. 
  
 

Modify Session 
The Modify Session button opens the Dialog box for the selected DICOM AE. In this window, 
the user may modify the Server and Client information described in the Add Session 
description. 

 

Remove Session 
The Remove Session button removes the selected DICOM AE configuration from the Vision 
software. Once removed, a DICOM AE configuration cannot be restored, unless the user 
manually re-enters the requisite data through the Add Session button.  A confirmation of 
action will be requested, see below. 
 
 
 
 
 

 6.7.0 Cont. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.7 
Verifying Removal of an 
Existing DICOM Network 
Connection  
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Association 
 
The Association List button opens the Association Dialog box, depicted below, through which 
the user can edit the parameters and protocols used by the Vision software when negotiating a 
connection with a remote DICOM AE. These options should only be modified by an advanced 
user familiar with DICOM association protocols. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Film Attributes 
 
Selecting the “Set DICOM Print Film Attributes” under the “Command” menu (Figure 6.7.9), 
displays the DICOM Printer Setup Dialog box. See Figure 6.7.10.  In this Dialog box, the user 
may select various options governing the film and print format.  Selecting Default restores all 
of the default options. Configurations to the settings are provided through drop down menus.  
To accept the modified configuration, select OK.  To reject the options and exit the window 
without making any changes, select Cancel.   
 
 
 
 
 
 

 6.7.0 Cont. 
 
 
 
 
Figure 6.7.8 
DICOM Association Window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.9 
Set DICOM PRINT FILM 
Attributes 
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PACS Print 
 
The PACS Print option sends the selected image to the selected PACS DICOM printer.  The 
image is printed according to the film, and print format options, found in the Set Film Attributes 
Dialog previously described. If the user initiates PACS Print from Image View, then the window 
level will be chosen, from the Image View. If PACS Print is initiated from the Database Dialog, 
then the Window Level will be the default window level, calculated by the Vision software. 
 
 

Close 
 
The Close button closes the DICOM Networking dialog box and returns the user to the area 
from which the DICOM command was executed.  This command also closes the connection or 
association, between the Vision software and the remote DICOM device, if a connection was 
established. 
 

  
6.7.0 Cont. 
 
Figure 6.7.10 
DICOM Printer Setup Dialog Box 
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Overview 
 
User Annotations in the Faxitron Vision Software allows a transparent graphic "overlay" 
commonly called "annotations" to be applied to an image. These annotations take the form of 
text, lines, "free form" lines (Bezier curves), arrows, ellipse and boxes. This allows additional 
information and "markers" to be added to the image if desired. Note that all annotations can be 
easily turned on or off, in other words they can be shown or hidden at will. 
 

Operation 
 
To begin annotating, select the Annotations tool from the left menu. See Figures 6.4.1 and 
6.8.1. By opening this dialog, the software will immediately put the user into design mode. It will 
also display a "Tool Pallet." See Figure 6.8.2 below.  

 

 

Selecting Save or Cancel from this dialog will either cancel the previous annotations or Save 
the current annotations to the window. It will also return you to normal imaging mode. 

The tool pallet consists of fifteen (15) tool options that follow. However, the tools may be 
truncated based on the needs of the user to the most common 8 tools, which are displayed in 
the top row of the dialog box.  

Note that the behavior of most of these tool options involve using the mouse to guide the on 
screen dynamic position and shape. Mouse "clicks" are used to set the final position and shape.  

The term "swipe" infers holding down the left-mouse button and moving the object around the 
screen. Letting go of the left mouse or clicking the right mouse button will "set" the annotation 
into a "permanent" or final position. 

 

 
 
Starting from the upper-left of the above figure a description follows of each tool option. 
 
 

  6.8.0 
User Annotations 
 
 
 
 
 
 
 
 
Figure 6.8.1 
User Annotation Design 
Tool Pallet 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.8.2 
User Annotation Design 
Tool Pallet 
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1. Selection Tool: Use this to select (highlight) a current annotation object. Click and hold 

the left mouse button down, which sets a starting position, then move the mouse around. 
Whatever annotations are inside the box being displayed will be selected, for further use. 
Release the left mouse button to finish the operation. 

 
2. Line Tool: Draw a straight line with this option. Mouse behavior same as above. 
 
3. Box Tool: Draws a box. Mouse behavior same as above. 
 
4. Ellipse (and Circle) Tool: Draws an Ellipse or circle. Mouse behavior same as above.  
 
5. Arrow Tool: Draws a line with an arrow at the end. Mouse behavior same as Line Tool. 
 
6. Polygon Open Line Tool: Draws non-straight "open segmented" lines. Left-click mice, 

hold button, draw. Release left button, this sets a line segment. Repeat as desired. Right-
click mouse button and tool operation is complete. 

 
7. Text Tool: Creates a "textbox" where you can type text-based data. 
 
8. Ruler Tool: Creates a ruled line segment. Very much like the Image Tools Ruler feature. 

 
9. Polygon Closed Line Tool: Draws non-straight "closed segmented" lines. Left-click mice, 

hold button, draw. Release left button, this sets a line segment. Repeat as desired. Right-
click mouse button and tool operation is complete. 

 
10. Curved Open Line Tool:  Draws curved "open segmented" lines. (Bezier curves.) Left-

click mice, hold button, draw. Release left button, this sets a curved-line segment. Repeat 
as desired. Right-click mouse button and tool operation is complete. 

 
11. Curved Closed Line Tool:  Draws curved "closed segmented" lines. (Bezier curves.) Left-

click mice, hold button, draw. Release left button, this sets a curved-line segment. Repeat, 
as desired. Right-click mouse button and tool operation is complete.  

 
12. Text "Balloon" Tool: Creates a textbox with a line segment protruding from a corner of 

the text box. This can be used to "link" text to something on your image. 
 
13. Segmented Ruler: Draws non-straight "open segmented" ruled lines. Left-click mice, hold 

button, draw. Release left button, this sets a ruled line segment. Repeat as desired. Right-
click mouse button and tool operation is complete. The length of all the ruled line segments 
is shown, at the end of the ruler. Useful for a rough estimate of the periphery of an object 
or Patient. 

 
14. Protractor Tool: Draws an angle on screen and provides the degree of the angle. Just like 

a protractor. 
 
15. Orthogonal Ruler Tool: Provides two (2) ruled lines that are at right angles to each other. 
 

 6.8.0 Cont. 
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Design Mode and Mouse Right-Click Menu 
 
While in User Annotation Design Mode, but not in a specific operation mode, one can right-click 
the mouse and get a context sensitive menu. See below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Many specific settings can be made from these context sensitive menus. 
 
Note: If an item seems too small to read or see correctly you can possibly change it from  
the Right click menus, shown above. Alternatively, you can choose to zoom into the image, using 
the Dynamic Zoom tool. This enlarges the image, and you should be able to clearly see any 
annotation. 
 
 
 

Show - Hide Annotations 
 
The Toggle Annotations button, shown as Figure 6.8.4, allows users to quickly 
toggle annotations on and off. By default, the annotations will be toggled on. The 
button is located in the right-side menu, near the upper right corner. 
 
 

  
6.8.0 Cont. 
 
 
 
Figure 6.8.3 
Right-click Mouse Context 
Sensitive Menu (Only During 
Design Mode of User 
Annotations) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.8.4 
Show/Hide Option For 
User Annotations 
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The “Help” menu, see Figure 6.9.1, is located on the top menu bar and provides quick access 
to the Faxitron Core “User’s Manual” and “About Vision”. Refer to Figure 6.10.1. 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
6.9.0 
Help 
 
Figure 6.9.1 
Help Menu 
 

 
The “About Vision” submenu opens a Dialog box, that shows the Vision software version, 
copyright, date and system information. 
 

 

  
6.10.0 
About Faxitron 
Vision Software 
 
Figure 6.10.1 
About Faxitron Vision Information 
Dialog Box 
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05-5280-04 
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Manual for the Bioptics Faxitron Core” 
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Faxitron. 
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Bioptics to Faxitron Bioptics. 
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covered in other sections. 
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• Insert New Section 2:  Radiation and 
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• Insert New Section 3:  About Your 
BioVision. 
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